# Table of Contents

Introduction ............................................................................................................................ 1
What is Clicker? .......................................................................................................................... 1
What’s New? ............................................................................................................................. 2
Registering Clicker .................................................................................................................. 3
Getting started ......................................................................................................................... 5
Starting Clicker ......................................................................................................................... 5
Using Quick Start ..................................................................................................................... 5
Browsing files and folders ........................................................................................................ 7
Navigating Clicker Explorer .................................................................................................... 8
Searching for files .................................................................................................................... 8
Using LearningGrids ............................................................................................................... 9
Writing in Documents ............................................................................................................. 11
Creating and opening a Document ......................................................................................... 11
Saving your Document ........................................................................................................... 11
Editing Documents .................................................................................................................. 12
Using the Document Toolbar ................................................................................................. 12
Editing Text .............................................................................................................................. 13
  Selecting text ....................................................................................................................... 13
  Moving/copying text .......................................................................................................... 13
  Deleting text ....................................................................................................................... 14
Formatting Text ......................................................................................................................... 14
Changing the layout of text .................................................................................................... 15
Finding Text .............................................................................................................................. 15
Using pictures in a Document ............................................................................................... 16
  Using pictures in a Document ........................................................................................... 16
  Positioning and resizing pictures ..................................................................................... 17
  Adding captions to pictures .............................................................................................. 18
Adding hyperlinks .................................................................................................................. 19
  Removing/Changing a hyperlink ....................................................................................... 19
Changing Document zoom .................................................................................................... 20
Changing the Page Setup ....................................................................................................... 20
Using writing support ............................................................................................................ 21
Using writing support ............................................................................................................ 21
Using Speech .......................................................................................................................... 22
Using word prediction ........................................................................................................... 22
  Using word prediction ..................................................................................................... 22
  Showing and hiding the Predictor .................................................................................... 23
Using keyboard shortcuts ..................................................................................................... 24
Using Instant Pictures .......................................................................................................... 24
Using grids ............................................................................................................................... 25
Using an on-screen keyboard ............................................................................................... 26
Spellchecking your Document ............................................................................................... 27
Document Analysis ............................................................................................................... 29
Using the Objects tab ....................................................................................................................... 68
Adding and deleting objects ................................................................................................................. 69
Selecting objects ................................................................................................................................. 70
Positioning and aligning objects ......................................................................................................... 70
Resizing objects ................................................................................................................................. 71
  Making objects the same size, width, or height ................................................................. 71
Moving and copying objects .............................................................................................................. 72
Changing Snap to Position .............................................................................................................. 72
Layering objects .............................................................................................................................. 73
Changing the background .................................................................................................................. 73
  Background positioning ............................................................................................................... 74
Transition sound effects .................................................................................................................. 74
Transition video effects ................................................................................................................... 75
Reordering cells .............................................................................................................................. 76
Setting the height of a grid ............................................................................................................... 77
Editing grids, pages, and pop-ups ................................................................................................. 77
Using the Objects tab ....................................................................................................................... 77
Adding and deleting objects .............................................................................................................. 78
Selecting objects .............................................................................................................................. 79
Positioning and aligning objects ..................................................................................................... 79
Resizing objects .............................................................................................................................. 80
  Making objects the same size, width, or height ................................................................. 80
Moving and copying objects ............................................................................................................ 81
Changing Snap to Position ............................................................................................................. 81
Layering objects ............................................................................................................................. 82
Changing the background ............................................................................................................... 82
  Background positioning ............................................................................................................ 83
Transition sound effects ................................................................................................................ 83
Transition video effects .................................................................................................................. 84
Reordering cells ............................................................................................................................. 85
Setting the height of a grid ............................................................................................................... 86
Using clusters .................................................................................................................................. 86
Using clusters ................................................................................................................................. 86
Selecting clusters and their cells ................................................................................................. 87
  Selecting clusters themselves ................................................................................................. 87
Adding and deleting cells in a cluster ............................................................................................ 87
Changing column widths of a cluster ........................................................................................... 88
Changing cell alignment in a cluster ............................................................................................. 88
Merging cells in a cluster ............................................................................................................... 89
Changing cell spacing in a cluster ............................................................................................... 89
Setting empty cell visibility in a cluster ....................................................................................... 89
Sorting cluster contents .................................................................................................................. 90
Imposing forced ordering .............................................................................................................. 90
Disassembling a cluster .................................................................................................................. 90
Using text boxes ............................................................................................................................. 91
Using text boxes ............................................................................................................................. 91
Adding content to text boxes ................................................................. 91
Text box properties ......................................................................................... 92
  Changing border and color ........................................................................... 92
  Insert a picture ................................................................................................ 92
Format text ....................................................................................................... 92
  Changing the layout of text ............................................................................ 93
Moving/copying text ......................................................................................... 93
Spellchecking text ............................................................................................ 93
Spellchecking a Clicker Set ............................................................................... 93
Changing object properties ............................................................................. 95
Changing object properties ............................................................................. 95
Altering object appearance ............................................................................... 95
  Changing border and color ........................................................................... 95
  Inserting a picture .......................................................................................... 97
  Editing an existing picture .............................................................................. 97
  Formatting text in an object .......................................................................... 98
  Further appearance options .......................................................................... 98
Sending text and pictures .................................................................................. 98
Playing sound ................................................................................................... 99
Playing Video ................................................................................................... 101
Opening items with objects ............................................................................. 102
  Opening items with objects .......................................................................... 102
  Show a pop-up ............................................................................................... 103
  Open the Keyboard ....................................................................................... 104
  Open the Sound Recorder ............................................................................ 105
  Open the Webcam .......................................................................................... 105
  Open Paint ..................................................................................................... 106
  Open Paint ..................................................................................................... 106
    Options tabs ................................................................................................. 106
      General options ........................................................................................ 106
      Tool options ........................................................................................... 107
      Color options ........................................................................................... 109
      Color options ........................................................................................... 110
      Sticky Point options ................................................................................ 111
      Advanced options .................................................................................... 113
    Using Sticky Points .................................................................................... 114
      Using Sticky Points .................................................................................. 114
      Editing Sticky Points ................................................................................ 115
      Adding Sticky Points ............................................................................... 116
      Moving Sticky Points ............................................................................... 117
      Deleting Sticky Points .............................................................................. 117
  Open a webpage ........................................................................................... 117
  Open the Print Dialog ................................................................................... 118
Altering window size and position ................................................................. 119
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structuring a Clicker Set</td>
<td>120</td>
</tr>
<tr>
<td>Using the Outline tab</td>
<td>120</td>
</tr>
<tr>
<td>Sequence Properties</td>
<td>120</td>
</tr>
<tr>
<td>Ordering a sequence</td>
<td>121</td>
</tr>
<tr>
<td>Adding new items to a Clicker Set</td>
<td>122</td>
</tr>
<tr>
<td>Using Masters</td>
<td>122</td>
</tr>
<tr>
<td>Creating new grids and pages</td>
<td>123</td>
</tr>
<tr>
<td>Creating a new pop-up</td>
<td>124</td>
</tr>
<tr>
<td>Pop-up size and location</td>
<td>125</td>
</tr>
<tr>
<td>Click &amp; Edit Mode</td>
<td>126</td>
</tr>
<tr>
<td>What is Click &amp; Edit?</td>
<td>126</td>
</tr>
<tr>
<td>How to use Click &amp; Edit</td>
<td>127</td>
</tr>
<tr>
<td>Play Mode</td>
<td>128</td>
</tr>
<tr>
<td>Configuring Click &amp; Edit</td>
<td>129</td>
</tr>
<tr>
<td>Clicker Set Properties</td>
<td>130</td>
</tr>
<tr>
<td>Media</td>
<td>130</td>
</tr>
<tr>
<td>Media</td>
<td>131</td>
</tr>
<tr>
<td>Temporary Libraries</td>
<td>131</td>
</tr>
<tr>
<td>Language</td>
<td>132</td>
</tr>
<tr>
<td>Spelling and Toolbars</td>
<td>133</td>
</tr>
<tr>
<td>Click &amp; Edit</td>
<td>133</td>
</tr>
<tr>
<td>Info</td>
<td>134</td>
</tr>
<tr>
<td>Using pictures, sound and video</td>
<td>137</td>
</tr>
<tr>
<td>Using pictures in Clicker</td>
<td>137</td>
</tr>
<tr>
<td>Adding pictures</td>
<td>137</td>
</tr>
<tr>
<td>Instant Pictures</td>
<td>138</td>
</tr>
<tr>
<td>Taking a webcam photo</td>
<td>139</td>
</tr>
<tr>
<td>Painting a picture</td>
<td>140</td>
</tr>
<tr>
<td>Adding pictures via &quot;drag and drop&quot;</td>
<td>141</td>
</tr>
<tr>
<td>Using sound and video in Clicker</td>
<td>143</td>
</tr>
<tr>
<td>Adding sound and video</td>
<td>143</td>
</tr>
<tr>
<td>Recording Sound</td>
<td>144</td>
</tr>
<tr>
<td>Adding sound and video via &quot;drag and drop&quot;</td>
<td>145</td>
</tr>
<tr>
<td>Managing Media Libraries</td>
<td>146</td>
</tr>
<tr>
<td>Managing Media Libraries</td>
<td>146</td>
</tr>
<tr>
<td>Registering a Media Library</td>
<td>147</td>
</tr>
<tr>
<td>Configuring Media Libraries</td>
<td>149</td>
</tr>
<tr>
<td>Languages in Media Libraries</td>
<td>150</td>
</tr>
<tr>
<td>Creating a new translation</td>
<td>150</td>
</tr>
<tr>
<td>The Media tab</td>
<td>150</td>
</tr>
<tr>
<td>Using the Media tab</td>
<td>151</td>
</tr>
<tr>
<td>Navigating the Media tab</td>
<td>151</td>
</tr>
<tr>
<td>Setting additional keywords</td>
<td>153</td>
</tr>
</tbody>
</table>
Using Media Browsers ........................................................................................................ 153
Using pictures, sound, and video ................................................................................................. 155
Using pictures in Clicker ............................................................................................................. 155
Adding pictures ............................................................................................................................ 155
Instant Pictures ............................................................................................................................ 156
Taking a webcam photo .................................................................................................................. 157
Painting a picture .......................................................................................................................... 158
Adding pictures via "drag and drop" ............................................................................................... 159
Using sound and video in Clicker ................................................................................................. 161
Adding sound and video via "drag and drop" .................................................................................. 163
Managing Media Libraries .......................................................................................................... 164
Managing Media Libraries .......................................................................................................... 164
Registering a Media Library ......................................................................................................... 165
Configuring Media Libraries ....................................................................................................... 167
Languages in Media Libraries ..................................................................................................... 168
Creating a new translation ............................................................................................................ 168
The Media tab ............................................................................................................................... 168
Using the Media tab ...................................................................................................................... 169
Navigating the Media tab .............................................................................................................. 169
Setting additional keywords ......................................................................................................... 171
Using Media Browsers ............................................................................................................... 171
Using Paint .................................................................................................................................. 173
Using Paint .................................................................................................................................. 173
Getting started .............................................................................................................................. 174
Paint tools .................................................................................................................................... 174
Rotate/Flip tools ............................................................................................................................ 174
Undo/Redo tools ............................................................................................................................ 175
Color Palettes ................................................................................................................................ 175
Color Palettes ................................................................................................................................ 175
Using the tools ............................................................................................................................... 176
Using the tools ............................................................................................................................... 176
The Brush tool ............................................................................................................................... 176
The Selection tool .......................................................................................................................... 176
The Fill tool ................................................................................................................................... 177
The Line tool .................................................................................................................................. 178
The Shape tool ............................................................................................................................... 178
The Text tool .................................................................................................................................. 179
The Stamp tool ............................................................................................................................... 179
The Eraser tool ............................................................................................................................... 180
The Selection tool .......................................................................................................................... 181
Colors, blends and patterns .......................................................................................................... 182
Colors, blends and patterns .......................................................................................................... 182
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color mixer</td>
<td>183</td>
</tr>
<tr>
<td>Color mixer</td>
<td>184</td>
</tr>
<tr>
<td>Using Sticky Points</td>
<td>184</td>
</tr>
<tr>
<td>How to use switches with Paint</td>
<td>185</td>
</tr>
<tr>
<td>Example activities</td>
<td>186</td>
</tr>
<tr>
<td>Creating a coloring-in activity</td>
<td>186</td>
</tr>
<tr>
<td>Creating a magic painting activity</td>
<td>187</td>
</tr>
<tr>
<td>Putting stamps on a background</td>
<td>188</td>
</tr>
<tr>
<td>Creating a matching activity</td>
<td>189</td>
</tr>
<tr>
<td>Printing your work</td>
<td>193</td>
</tr>
<tr>
<td>Printing a Document</td>
<td>193</td>
</tr>
<tr>
<td>Printing a Clicker Set</td>
<td>194</td>
</tr>
<tr>
<td>Advanced Options</td>
<td>195</td>
</tr>
<tr>
<td>User Preferences</td>
<td>197</td>
</tr>
<tr>
<td>Preference tabs</td>
<td>197</td>
</tr>
<tr>
<td>Document</td>
<td>197</td>
</tr>
<tr>
<td>Speech</td>
<td>199</td>
</tr>
<tr>
<td>Media</td>
<td>200</td>
</tr>
<tr>
<td>Clicker Sets</td>
<td>202</td>
</tr>
<tr>
<td>Predictor</td>
<td>203</td>
</tr>
<tr>
<td>Look and Feel</td>
<td>204</td>
</tr>
<tr>
<td>Accessibility</td>
<td>205</td>
</tr>
<tr>
<td>Using switches</td>
<td>205</td>
</tr>
<tr>
<td>Using Scan Groups</td>
<td>206</td>
</tr>
<tr>
<td>Changing User Access options</td>
<td>207</td>
</tr>
<tr>
<td>Scan options</td>
<td>207</td>
</tr>
<tr>
<td>Pointer Options</td>
<td>208</td>
</tr>
<tr>
<td>Display options</td>
<td>210</td>
</tr>
<tr>
<td>Using the Scan tab</td>
<td>211</td>
</tr>
<tr>
<td>Using the Scan tab</td>
<td>211</td>
</tr>
<tr>
<td>Scan Group settings</td>
<td>212</td>
</tr>
<tr>
<td>Full Screen options</td>
<td>212</td>
</tr>
<tr>
<td>Saving your preferences</td>
<td>213</td>
</tr>
<tr>
<td>Using different languages</td>
<td>215</td>
</tr>
<tr>
<td>What changes?</td>
<td>215</td>
</tr>
<tr>
<td>Setting a language</td>
<td>216</td>
</tr>
<tr>
<td>Clicker Apps</td>
<td>217</td>
</tr>
<tr>
<td>Getting help</td>
<td>219</td>
</tr>
<tr>
<td>Technical Support</td>
<td>219</td>
</tr>
</tbody>
</table>
Introduction

What is Clicker?

Clicker is the proven reading and writing tool that helps students of all abilities to achieve rapid and permanent gains in their levels of reading and writing. Clicker is used extensively within mainstream education across the world and supports a wide range of special needs. You can use Clicker to support teaching and learning in any subject area – and it’s so easy to use!

It has a talking word processor, which you can write in using a keyboard, or by clicking words and pictures in the on-screen Clicker Grids. You can hear the words spoken beforehand and have sentences read back to you. The Predictor provides a list of word suggestions as you type. Clicker 6 makes it easy to create an engaging variety of learning activities.
But it's not just for writing – you can also use full screen Clicker Pages for a wide range of uses, such as talking books, multimedia presentations, and labeling activities. Using Click & Edit, a student can work independently and write their own books, populating it with pictures and sounds, without the need for supervision.

Clicker 6 comes with a series of powerful wizards and high-quality media support so you can rapidly make useful and attractive teaching materials. The realistic speech support reinforces learning and enables effective literacy and language teaching.

It's such a versatile tool; the only limit is your imagination!

**What’s New?**

We’ve made a number of improvements to Clicker, having listened to Clicker users around the world. Clicker 6 makes use of the latest technologies to make teaching more effective and has a number of improvements over version 5, as well as many new features:

**User Independence**

- Quick Start – lets users get started by themselves
- Click & Edit – puts your students in control
- Favorites/Recent files – easy access to regularly used files
- Enhanced integration with LearningGrids. No need to log in!
**Document support**

- Built-in *word prediction* using WordFlow™ including next word and phonetics
- New ways of creating images using a *webcam* or *Paint*
- Position pictures through *intuitive dragging*
- Enhanced graphics library featuring thousands of new and better quality pictures
- **Document Analysis** – see which spellings were corrected
- **Document Page View** – easily adjust the zoom level and snap it to the page width

**Edit Mode**

- *New and improved*, redesigned for easier use. The *Editing Toolbar* makes common tasks just a click away
- Powerful * wizards* for quickly creating detailed activities
- The ability to undo/redo actions
- Make objects any color you like and alter cell border thickness and style
- *Cell clusters* make it easy to create word banks and forced order activities
- Search your *Media Libraries*
- Easily specify *sounds to play when transitioning* between grids/pages
- *Spellcheck* Clicker Sets

**User Access**

- *Mouse Dwell* – a convenient access method for users unable to click mouse buttons
- *Sound Shift* – play right-click sounds with a left click (or a dwell if used with the above)
- Custom user *color schemes* to enhance contrast and general visibility
- Cells can change color/enlarge on rollover

**All your Clicker 5 sets will work in Clicker 6.**

**Registering Clicker**

Register now at [http://activate.cricksoft.com/register](http://activate.cricksoft.com/register)

Registration is **free** and gives you:

- Free software updates
- Free technical support
- Free retrieval of lost serial numbers
Not sure if you’ve already registered? Just start the registration process by entering your serial number – if you have already registered, the website will tell you.

**Warning**: Crick Software cannot issue new serial numbers, and you cannot install the software without one. You are therefore **strongly advised** to register your serial number now in case you lose it.
Getting started

Starting Clicker

To launch Clicker, open the Start menu, hover over All Programs, and then Crick Software, before selecting Clicker 6.

When Clicker starts, the Clicker Explorer window displaying the Quick Start tab appears.

The Quick Start tab provides an interface that enables students to quickly start using Clicker 6 by themselves. They can start writing a new Document, make a book using Click & Edit or open an existing Clicker Set or Document. Teachers can also click Make a Clicker Set to quickly start creating their own activities.

Click the Files tab to open any files on the computer or network. For more information, see Browsing files and folders.

If you are new to Clicker, we recommend that you open the example Clicker Sets that are provided with Clicker to get an idea of what the program can do. You can also visit the Clicker 6 section on our website, where we will be posting articles and videos guides for new users. Additionally, training booklets will be available to order from our website, which contain classroom ideas and tasks that guide you step-by-step through creating your own resources.

To leave Clicker, close the program as you would any other - click the X button at the top right corner of the window. You will be asked whether you wish to save any open Documents or Clicker Sets.

Using Quick Start

When Clicker 6 starts, Quick Start is displayed to allow students to quickly start using Clicker.
Quick Start contains a number of options:

- **Start writing** – choose **New Document** to start work on a blank Document

- **Make a book** – start work on a new book in Click & Edit mode, which allows you to use simple editing tools only. Choose one of the available layouts

- **View favorites** – open one of the Clicker Sets saved in your list of favorites

- **Recent files** – choose a recently opened Document or Clicker Set to continue working on it

- **Make a Clicker Set** – create a new Clicker resource to use with your students

If you have a **user profile**, select it from the list in the top right corner. This will personalize Clicker for you by setting up your personal user preferences and displaying your favorites and recent files. Select **None** to load the last settings used. The user profile list will only appear if there are any user profiles to display.

To view all files and folders, click the **Files** tab. For more information see **Browsing files and**
You can return to the Quick Start menu at any time by clicking the **Explorer** icon at the bottom left of the window, or in the **Document Toolbar**, and then opening the **Quick Start** tab.

**Browsing files and folders**

**Clicker Explorer** allows you to open Clicker Sets and Documents from several locations on your computer, your network and even the Internet.

Click on one of the shortcuts on the left to jump to common locations for files and folders:

- 🏡 **Shared Files** – view the contents of your **Shared Clicker Files folder**.
- 🌐 **Free Resources** – search for and run resources directly from **LearningGrids**.
Computer – view your computer's hard drives, removable disks, and network shares.

Desktop – view the contents of your computer’s Desktop.

My Documents – view the contents of your My Documents folder.

Note: Some of these shortcuts are unavailable when you are saving a file.

Use Clicker Explorer in a similar way to Windows Explorer – double-click a folder to view its contents and double-click a file to open it. If you right-click a file or folder, you can choose to Rename or Delete it. Right-click anywhere within the current folder to create a new one.

Clicker Explorer will show you different types of files depending on what you are doing, such as opening a Document. Use the Show filter at the bottom to choose which type(s) of files are displayed.

Navigating Clicker Explorer

The Clicker Explorer tools along the top help you to find your folders and files:

Back and Forward – move between folders you’ve viewed.

Up – go to the folder that contains the current one.

View – choose between different sizes of icons.

As you browse through folders, the address bar near the top will display the current file path. Click any folder name along that path to go to that folder and click the arrow after a folder name to open a different subfolder.

Searching for files

You can search for files and folders by using the search box:
Type the name, or part of the name, of the file or folder you are looking for (such as school above) into the search box and click Search (or press Enter). Clicker Explorer will search the current folder and any subfolders for any matches to your search term.

The search results are displayed in the files and folders area. To clear the search results and return to the previous view, click Back.

**Using LearningGrids**

LearningGrids.com is a website containing thousands of free resources for Clicker and other Crick Software titles. It continues to be updated with new content every two weeks.

Although you can browse the site through an Internet browser, you can also access a specialized version through Clicker itself and run resources directly, without having to save them first. For the first time, it is not necessary to create an account in order to access LearningGrids directly from within Clicker!

To get started, click the Explorer icon at the bottom left of the window, or in the Document Toolbar, and click the Free Resources icon on the left.
**Note**: If LearningGrids does not display, this indicates that Clicker is unable to connect to the website. If you’re using Clicker while connected to your organization’s network, it could be being blocked by a proxy server. Visit the [support section](#) at our website for further help.

LearningGrids has been designed to be easy to use and navigate. You can browse resources by the various categories on the left, or you can search for resources using the search box at the top. You can even filter resources by age using the slider in the top right.

Each resource has a description and a thumbnail. As you hover the mouse cursor over a resource, two buttons will appear towards the right. Click **Run Now** to immediately start the resource in Clicker. Click **View** to read more information about it first.
Writing in Documents

Creating and opening a Document

To create a new Document, click the New Document on the Document Toolbar, or open the Document menu and select New Document. You will be asked to save any existing work before you are presented with a new, blank page.

To open a previously saved Document, click the Explorer icon on the Document Toolbar, or open the Document menu and select Open Document.

Browse to the Document you wish to open, select it and click Open. You will be asked to save any existing work. For further help with using this window, see Browsing files and folders.

To easily open a Document (or Clicker Set) you have used recently, click the Favorites icon on the Document Toolbar, open the Recent files tab and then click the file you want to open.

Clicker 6 supports the following types of Document file:

- Clicker 6 Document (.cdoc)
- Microsoft Word Document (.doc or .docx)
- Webpage (.html or .htm)

Saving your Document

To save your Document, click the Save icon on the Document Toolbar, or open the Document menu and select Save Document.

If the Document has not been saved before, you will be asked where you want to save it. Enter a name for your Document, browse to where you want to save it, and click Save. The next time you save the Document, you will overwrite the current file with a newer version.

If you want to save your Document somewhere else or with a different name, open the Document menu and select Save Document As.

You can also choose what type of file you want to save. Clicker 6 supports the following types of Document file:

- Clicker 6 Document (.cdoc)
- Microsoft Word Document (.doc or .docx)
Tip: You can change the default Document file type in the Document tab in User Preferences.

**Editing Documents**

**Using the Document Toolbar**

Clicker features a variety of word processing tools in a switch accessible toolbar along the top of a Document. Some of the tools have a black arrow underneath; click this arrow to open more tools. Click the links below to find out more about a particular function.

- Create a new Document
- Open Clicker Explorer
- View Favorites and Recent files
- Save your Document
- Print your Document or Clicker Set
- Change the look of text
- Change the layout of text
- Spellcheck your Document
- Cut the selected text
- Copy the selected text
- Paste from the clipboard
- Undo the last edit in the Document
- Redo the last edit that was undone
- Insert a picture
- Speak text or change the voice
- Hide or show the Predictor
- Change the Document magnification

**Note:** You can change which tools are available on the Document Toolbar, or hide it completely. See the Look and Feel tab in User Preferences.
Editing Text

Editing text within a Document is similar to other word processors, such as Microsoft Word.

Once selected, text can be positioned and moved around the Document; it can be cut/copied and pasted to/from external sources; it can be formatted to appear in different colors and font types, in addition to being highlighted in a chosen color, and more.

Selecting text

To select text, click and hold the mouse button at the beginning of the section of text you wish to edit, and then move the mouse pointer to the end of your desired section before releasing the mouse button.

You can also double-click a word to select it, or triple-click a paragraph to select it. Additionally, you can select the entire Document text by opening the **Edit** menu and clicking **Select All Text**, or by pressing **Ctrl-A**.

To deselect selected text, click anywhere else in the Document.

Moving/copying text

To move selected text, click and drag it to where you want it. You can copy the text by holding **Ctrl** while you drag.

You can also move or copy selected text using the **Copy**, **Cut**, and **Paste** functions, which are located in the **Document Toolbar** and the **Edit** menu, or you can use your keyboard.

- **Copy** – click the [Copy icon](#), select *Copy* in the Edit menu, or press **Ctrl-C**

- **Cut** – click the [Cut icon](#), select *Cut* in the Edit menu, or press **Ctrl-X**

- **Paste** – click the [Paste icon](#), select *Paste* in the Edit menu, or press **Ctrl-V**

Using **Copy** on selected text will copy it to the clipboard, which is a temporary storage area on your computer. Using **Cut** on selected text will do this, and also delete the original text.

You can then use **Paste** to insert the clipboard text to your chosen location.
Note: These functions can be used in other programs, so you can **move** or **copy** text both to and from the Document.

Deleting text

To delete selected text, open the **Edit** menu and select **Delete**, or press the **Delete** key on your keyboard.

Formatting Text

To change the look of the text in your Document, click the ![Text](image) icon on the Document Toolbar. This will display the list of formatting tools below, most of which also appear in the **Format** menu:

- To change the font style, select one from the drop-down list. Start typing the name to find it quickly
- To change the text size, select a size from the drop-down list or type a number and press **Enter**
- To make text **bold**, **italicized**, or **underlined** click the **B** Bold, **I** Italic or **U** Underline icons respectively. Alternatively, hold the **Ctrl** key and press **B**, **I**, or **U**.
- To change the color of text (as shown by the icon), click the **Font Color** icon. To use a different color, click the arrow to the right of the icon and select one from the color palette
- To highlight text in the Document, click the **Highlight** icon and then select some text. To change the highlight color, click on the arrow to the right of the icon. To stop highlighting text, click the tool again

To make the text **superscript** or **subscript**, open the **Format** menu and select **Superscript** or **Subscript**. Apart from the **Highlight** tool, these tools affect any further text you type. You can also format existing text by **selecting the text** before using the tools.
**Tip:** You can change the default Document font settings in the Document tab in User Preferences.

---

### Changing the layout of text

To change the layout of text in your Document, click the Layout icon on the Document Toolbar. This will display the layout tools below, which also appear in the Format menu:

- To **align** text to the left, center or right of the Document, click **Align Left**, **Align Center** or **Align Right** icons respectively
- To start new paragraphs with **numbers**, click the **Numbering** icon. Click it again to disable it
- To start new paragraphs with **bullet points**, click the **Bullets** icon. Click it again to disable it

To increase or decrease the distance between the margin and the start of the text, open the Format menu and select **Increase Indent** or **Decrease Indent**.

To change the **spacing** between lines of text, open the Format menu, select **Line Spacing**, and then select a spacing option.

**Note:** You can change existing text by selecting it before using these tools.

---

### Finding Text

To find a word or phrase in your Document, open the Edit menu and select **Find**, or press Ctrl-F.
Type the text you wish to locate in the **Find** box, and then choose options for searching:

- **Match Case** – check this to search for text that matches the letter case you have typed
- **Find Whole Words Only** – if searching for text that might appear in the middle of a word, check this to find only whole words that match the text you have typed

Click **Next** to find the next instance of the text in the Document, or **Previous** to search the text backwards from the current position.

**Using pictures in a Document**

To add a picture to your Document, click where you would like the picture to go and click the **Picture** icon on the **Document Toolbar**, to display the following tools:

- To add a picture from a **Media Library**, the current Clicker Set, your computer, or another device, click the **Browse** icon to open a **Picture Browser**. When you have browsed to your desired picture, select **Insert**.
- To paint a picture, click the **Paint** icon. For further help, see **Painting a picture**
- To take a photo with a webcam, click the **Take Photo** icon. For further help, see **Taking a photo**

You can also drag pictures into your Document from Windows Explorer, or from a web page - see **Adding pictures via "drag and drop"** for more information.
To **remove** a picture from your Document, click it once and press the **Delete** key on your keyboard. Alternatively, you can right-click it and select **Delete**.

**Note:** You can also use **Instant Pictures**, where pictures automatically appear over matching words as you type. To enable this, view the **Media** tab in **User Preferences**.

---

**Positioning and resizing pictures**

To resize a picture in the Document, click it to show its **bounding box**. You can then click and **drag** the **corner handles** to resize the picture.

To move a picture in the Document, click on it and drag it to a new position. As you drag the picture across the Document, indicators appear to tell you how the text will wrap around the picture when you release the mouse button:

---

Position to the left:

the picture is fixed to the left of the page; text is displayed to the right of the picture
Position in the center:
The picture is fixed in the centre of the page; text appears above and below the picture, but not next to it.

Position to the right:
The picture is fixed to the right of the page; text is displayed to the left of the picture.

You can also change the position of a picture by right-clicking it and making a selection from Position in its pop-up menu.

Adding captions to pictures

To add a caption to a picture in the Document:

1. Right-click the picture to view its pop-up menu
2. Select Add Caption
3. Type the caption for the picture
4. To finish editing the caption, click somewhere else in the Document

To remove a caption from a picture, right-click the picture and select Remove Caption from the pop-up menu.
**Adding hyperlinks**

You can add a hyperlink to your Document so you can click on a word or phrase to go to a website or write an email.

To add a hyperlink:

1. **Select the text** that you wish to turn into a hyperlink

2. Open the **Insert** menu and select **Hyperlink**, or press **Ctrl-K**

   ![Hyperlink dialog box](image)

- To open a web page, select **Web Address** from the **Type** drop-down list and then type the web address in the **URL** text box. For example, [http://www.cricksoft.com](http://www.cricksoft.com)

- To send an email, select **Email Address** from the **Type** drop-down list and type the email address in the **URL** text box. For example, [mailto:info@cricksoft.com](mailto:info@cricksoft.com)

- To create any other kind of hyperlink (for example, to an **FTP** location), select **Other** from the **Type** drop-down list and type the full location (including protocol prefix) in the **URL** text box

The selected text will become blue and underlined. Click it to visit your link.

**Removing/changing a hyperlink**

To remove or change a hyperlink in your Document:

1. **Select** the text that contains the hyperlink

2. Open the **Insert** menu and select **Hyperlink**, or press **Ctrl-K**

3. Then do one of the following:
• To remove the hyperlink, click **Remove Hyperlink**

• To change the hyperlink, change the **Type** and/or the **URL**

### Changing Document zoom

To change the Document magnification level, click the **Zoom** icon on the Document Toolbar to show the following tools:

- To increase or decrease the Document magnification, click the [Increase Zoom](#) or [Decrease Zoom](#) icons

- To make the Document the same width as the screen, click the [Toggle Fit Width Mode](#) icon (click again to disable)

### Changing the Page Setup

To change the paper size, orientation and margins for the Document, open the Document menu and select **Page Setup**.

You have the following options:
• **Paper** – to change the paper size to something such as **Letter**, select an option from the drop-down list

• **Orientation** – select a **Portrait** (vertical) or **Landscape** (horizontal) layout for the Document

• **Margins** – to change the margins that are used around the Document, enter numbers in the boxes

Click **Default** to reset the options.

**Using writing support**

Using writing support

Clicker comes with several different tools to support students in their writing. They are flexible and configurable, allowing for different levels of support for students of all abilities.

• Have Clicker **read text back** that has been written in the Document

• Use the **Predictor** to supply powerful **word prediction**

• Automatically **illustrate typed words** with pictures
- Use various types of grids to allow students to write by clicking cells
- Students can type using an on-screen keyboard
- Perform spellchecking using a student-friendly tool

**Using Speech**

To hear text in the Document, click the 🎧 **Speak Text** icon in the **Document Toolbar**. Clicker will read the current Document back to you and highlight the words as it speaks.

To hear a particular section of text, **select it** and click 🎧 **Speak Text**. Selected text will be read automatically if **Sound Shift** is enabled. By default, you can also hear individual words by clicking anywhere within them with the left or right mouse button.

To change the voice of the speech, click the arrow to the right of 🎧 **Speak Text** and select a speech engine from the drop-down menu. Choosing a different language speech engine will also change the language for other items. See **Using different languages** for more information.

Clicker can also speak letters, words, and sentences automatically. By default, Clicker will read sentences back to you when completed with a punctuation mark. You can change speech preferences regarding speed, highlighting, and automatic speech options on the **Speech** tab in **User Preferences**.

---

**Tip:** You can listen to words in cells or the Predictor, by right-clicking them. For more information, see **Using sound** or **Using the Predictor**.

---

**Using word prediction**

**Using word prediction**

As you type, the **Predictor** tracks the position of the cursor and shows a list of words it thinks you are most likely to want to use.
The Predictor uses a combination of three methods to predict words:

- **Context**
- **Letters** you have typed so far
- **The sound** of the letters you have typed so far

Click words in the list to add them to your Document. To hear a word before you add it, right-click it, or use the Sound Shift tool. You can also use the keyboard to send and hear words.

The Predictor can use Clicker’s Instant Picture support to show matching pictures alongside suggested words. To enable this, see the Media tab in User Preferences.

You can fully customize the behavior and appearance of the Predictor on the Predictor tab in User Preferences.

**Tip:** You can get Predictor support in Clicker Sets when using text boxes.
To show or hide the Predictor, click the ![Predictor](image) icon on the Document Toolbar, or open the View menu and select Show Predictor. You can also hide the Predictor by clicking the ![Hide Predictor](image) icon on the Predictor itself.

To resize the Predictor, click the bottom-right corner and drag until the Predictor is the size you want. The text will automatically resize to fill the space available.

To move the Predictor, click and drag the Predictor by its bottom toolbar. It will stay in this chosen position until it is dragged back below the current word, or Clicker is restarted.

### Using keyboard shortcuts

You can use the number keys on your keyboard to add words to your Document and hear them spoken, which can be quicker than using the mouse. To enable this, click the ![Use Number Keys](image) icon on the Predictor itself. This will cause a number to be displayed for each word in the list.

To send a word to your Document, press the key on your keyboard that corresponds to the number of the word you want to send. You can use the number keys at the top of the keyboard or those on the numeric keypad (if your keyboard has one). You can also hold Alt and press a number to send that word. (This works even when Use Number Keys is not enabled.)

To hear a word, hold Ctrl and press a number to hear that word.

---

**Note:** To set which keys are used to control the Predictor, see the Predictor tab in User Preferences.

---

**Tip:** The Predictor is switch accessible.

---

### Using Instant Pictures

When using Instant Pictures support, pictures from your Media Libraries appear above typed words or phrases that match their filename and defined keywords.
You can also show Instant Pictures in the Predictor, the Spellchecker, and in Clicker Sets.

Sometimes, several pictures might have the same filename/keywords (possibly across different libraries). When this happens, the picture shown is from the Media Library with the highest priority that has been checked to be used with Instant Pictures. You can cycle through other available pictures for that word by double-clicking the current one, or selecting it and pressing the F12 key on your keyboard. To determine the order that Media Libraries are searched for pictures, see the Media tab in User Preferences.

To remove an Instant Picture from the Document, click it and press the Delete key on your keyboard.

**Note:** You can specify keywords in addition to a picture’s filename for use with Instant Pictures. See Setting additional keywords.

**Tip:** You can also force Instant Pictures in the Document when a particular Clicker Set is open. See the Media tab in the Clicker Set Properties.

**Using grids**

Grids are a powerful and versatile way of providing writing support when composing a Document.
A grid is a panel in which cells and other objects can be placed, similar to a notice board. Typically, they sit in the bottom half of the screen, with the Document in the top half. Cells are rounded shapes that can contain text and/or a picture. Since a cell will send its contents to the Document when clicked, students can use grids alongside (or instead of) the computer’s keyboard to type their work. They can right-click a cell (or use Sound Shift) to hear Clicker speak its contents.

You can also configure cells to open things like the Sound Recorder or a Paint window.

Through the use of cells placed on a grid, you can arrange various words, phrases and pictures to create interesting and challenging writing activities for students. For example, cells can be color coded and only selectable in order, which is fantastic for teaching sentence structure.

Grids can be grouped together and sequenced in a Clicker Set to provide help for an entire piece of writing. You can even have multiple Clicker Sets open at the same time. Because you are their designer, using grids is a perfect way to provide scaffolded learning. Grids can be designed to handle a wide range of activities at differentiated levels suitable for all students.

To get started, look at the example Clicker Sets that are provided. Open the Clicker Explorer window, click the Shared Files icon, and then double-click the Examples folder.

For further information, see Using grids with Documents.

**Using an on-screen keyboard**
You can write in the Document using an on-screen keyboard as an alternative to a physical one. The on-screen keyboard can open automatically when you start the program.

To open the on-screen keyboard, click the **Show Keyboard** icon on the **Grid Toolbar**, or open the **View** menu and select **Show Keyboard**. To close it, repeat these actions or click the **Close** icon on the keyboard itself.

To choose your preferred on-screen keyboard and whether it opens when Clicker starts, see the **Clicker Sets** tab in **User Preferences**.

**Tip:** To customize the included on-screen keyboards and create your own, see *Creating and editing a keyboard*.

**Note:** You can also use Clicker Sets to provide more structured writing support. For more detailed help, see *Using grids*.

### Spellchecking your Document

To check the spelling in your Document, click the **Spell Check Document** icon in the **Document Toolbar**, or open the **Edit** menu and select **Spelling**.
Note: Clicker will automatically use the Spellchecker for the language you are writing in. If you cannot spellcheck your Document, it is because no Spellchecker is available for that language. For further information, see Using different languages.

The Spellchecker looks through your Document for words that are not in the dictionary. If it finds a word it does not recognize, it highlights the word and offers alternative spellings in a pop-up Spellchecker. To change the spelling, click on a word in the Spellchecker. To leave the spelling as it is, click the Next Word button. The Spellchecker then continues looking though the Document for further misspellings.

The Spellchecker can use Clicker’s Instant Picture support to show pictures above matching spelling suggestions. To enable this, see the Media tab in User Preferences.

Clicker checks your spelling as you type and will underline misspelled words in red. You can then right-click one of these words to select from a list of alternative spellings. Clicker can automatically capitalize the start of sentences and names. To enable these features, see the Document tab in User Preferences.

Clicker keeps a record of how the Spellchecker has been used in each Document. For more information, see Spelling Corrections when using the Document Analysis tool.
Note: You can also check the spelling of a Clicker Set.

Document Analysis

Clicker 6 includes a tool that presents information about the current Document. Along with statistics such as word count and average sentence length, there is a record of all spelling corrections made by the Spellchecker.

To view any of this information for the current Document, open the Document menu and select Document Analysis.

You can save the information contained in the Document Analysis tool in HTML format by clicking Save.

To print the Document Analysis information, click Print. This will open the file in your default web browser. Use your browser’s print option to print the file.

Statistics and spelling corrections

Statistics

The Statistics tab is shown by default, and shows you the:

• number of words
• number of characters (with and without spaces)
• number of sentences
• average number of words in a sentence
• number of paragraphs

Spelling Corrections

On the Spelling Corrections tab, you can see the corrections that have been made with the Spellchecker.
Under the **Spellchecker History** title, the words that the Spellchecker has corrected are listed in alphabetical order. The original misspelling is shown to the right of the hyphen. If the context is not shown automatically, click the + **sign** next to a misspelling in order to view it in the context of the Document.
Clicker Sets

About Clicker Sets

Clicker Sets are the unique feature that separate Clicker 6 from ordinary word processors and make it a most valuable learning tool. They include:

- **Grids**
- **Pages**

These can provide support when writing a Document, or be used to produce interactive activities and tasks.

To get started, look at the example Clicker Sets that are provided. Open **Clicker Explorer**, click the **Shared Files** shortcut, and then double-click the **Examples** folder. You can download more Clicker Sets from LearningGrids and buy professionally made "Powered by Clicker" resources from our website.

And of course, you can make your own resources and share them with other users! Clicker 6 features a powerful Edit Mode, which has been completely redesigned to be more user-friendly. Making your own Clicker Sets is fun and engaging, and the best part is that you can tailor them specifically to your students' needs. You can create a Clicker Set entirely from scratch, based on a **template** or use one of the included **wizards** to make intricate, detailed activities in seconds.

**Note:** To make changes to an existing Clicker Set, see **Editing Clicker Sets**. You can also **create a new Clicker Set**.

Grids

A **grid** is a panel in which cells and other **objects** can be placed, similar to a notice board. Typically, they sit in the bottom half of the screen, with the Document in the top half. Cells are rounded shapes that can contain text and/or a picture.
Since a cell will send its contents to the Document when clicked, students can use grids alongside (or instead of) the computer’s keyboard to type their work. They can right-click a cell (or use Sound Shift) to hear Clicker speak its contents.

Cells are incredibly versatile, and can be configured to do all sorts of things, from recording sound to opening a pop-up and taking a webcam photo. Other cells can be used to play/show content that has been created.

A pop-up is a special type of grid that is designed to be shown only when a button is pressed. For more information, see Using Pop-ups.

**Writing with grids**

When you open a Clicker Set that contains a grid, it will be displayed beneath your Document when you view it. You can then use the cells in the grid to edit your Document.

To send words and pictures from the grid into the Document, click on them. The cell will send to the position of the cursor in the Document.

Right-click on cells to hear them before you send, or use the Sound Shift icon.

Click here for information about using grids as writing support.

**Using the Grid Toolbar**
When a grid is opened, the switch accessible Grid Toolbar is displayed between the grid and the Document. It contains the following tools:

- **Back** and **Forward** – move between grids and pages in the Clicker Set
- **Sound Shift** – turn Sound Shift on or off
- **Open Keyboard** – opens your preferred on-screen keyboard
- **Delete Letter** – removes the character to the left of the cursor in your Document
- **Delete Word** – removes the word (or phrase) to the left of the cursor in your Document
- **New Line** – moves the cursor to a new line in your Document
- **Hide** – hides the grid area. Click **Show Grid Area** on the bottom status bar to show it again

**Note:** You can change which tools are available on the Grid Toolbar, or even hide it completely. See the Look and Feel tab in User Preferences. The Back and Forward tools may be hidden by the current Clicker Set, see Sequence Properties.

---

**Using Sound Shift**

You can right-click many things in Clicker to get an auditory response. For example, right-clicking cells in a grid will speak their text content by default, and right-clicking the icons in the Document Toolbar will describe their function. Not everybody is able to use right-click, particularly on touch screen devices or interactive whiteboards. In these circumstances, you can use the Sound Shift icon located on the Grid Toolbar.
Using Sound Shift will allow you to use a left-click to hear the sounds you would normally hear if using right-click. The cursor will change to a **Speaker** icon when hovering over a relevant item. Additionally, it will read **selected text** in the Document when enabled.

**Double-click** the icon to enable or disable Sound Shift. A **single click** will only enable the tool for **one click**.

**Changing a grid's height**

You can temporarily change the height of a grid to increase or decrease the size of the text and pictures:

1. Move the mouse cursor to the top of the grid area so the mouse pointer becomes a **double-headed arrow**

2. Click and drag the double-headed arrow up or down to increase or decrease the grid height. When you’re happy with the size, release the mouse button

---

**Tip:** You can also **save the grid height** so that it is the same whenever the grid is used.

---

**Pages**

**Pages** can be thought of as **full-screen grids**. They are designed to be interacted with as activities in their own right, unlike grids which work with the Document. For example, these could be activities that include combinations of words/pictures/sounds to be labeled or matched.
You can use pages to create books that facilitate interactive storytelling using various types of media. The new **Click & Edit** feature enables students to write their own stories too! It is possible to create blank books with a designed layout that features no content. A student can then work through the book, using the Click & Edit tools to fill it with their own content. For more information about this feature, see [Using Click & Edit](#).

**Pop-ups**

These are smaller, specialized grids that are designed to appear in front of an ordinary grid or page when opened, usually by clicking a button or cell.
Because they are a type of grid, pop-ups can do anything that ordinary grids can. You can insert cells and clusters, which can be configured to display pictures, open grids/pages, take photos, record sound, or even open another pop-up!

For example, the Sentence Building wizard can create sentence building activities that can display the model in a pop-up via a button.

Pop-ups can also be used to send text and pictures to a Document, or to any other cell or text box in the current Clicker Set.

To add a pop-up to a Clicker Set, see Creating a new pop-up.

When you have created a pop-up, you can edit it just like a normal grid or page. For more information, see Editing a Clicker Set.

You can also configure a cell to open a pop-up when it is clicked: see Show a pop-up.

**Managing Clicker Sets**

**Opening a Clicker Set**

To open a Clicker Set, open **Clicker Explorer** on the Document Toolbar (the Click & Edit Toolbar if using Click & Edit). Alternatively, open the Clicker Set menu and select Open Clicker Set. Browse to your chosen Clicker Set, select it and click Open.
To quickly open a Clicker Set from your list of favorites, click the Favorites icon on the Document Toolbar, open the Favorites tab and select the Clicker Set you want to open. You can access the same list by opening the Clicker Set menu and hovering over Favorites. For information about managing your favourite Clicker Sets, see Managing Favorites.

To show a list of recently opened files, click the Favorites icon, open the Recent files tab and select the Clicker Set you want to open. You can also access this list under Recent files on the Quick Start tab.

**Note:** In the Options menu, you can click Clear Favorites & Recent Files to clear both these lists.

When more than one Clicker Set is opened, their tabs will appear at the bottom of the screen. Click these tabs to switch between open Clicker Sets.

### Closing a Clicker Set

When more than one Clicker Set is opened, their tabs will appear at the bottom of the screen.

Click x on an individual Clicker Set tab to close it.

Alternatively, select Close Clicker Set from the Clicker Set menu, where you can also close every open Clicker Set by selecting Close All Clicker Sets.

You will be prompted to save any changes before closing a Clicker Set.

### Saving a Clicker Set
To save a Clicker Set, click the Save icon near the top right corner of the Editing Toolbar, or open the Clicker Set menu and select Save Clicker Set. You can also click the Save icon on the Click & Edit Toolbar if applicable.

If the Clicker Set has not been saved before, you will be asked where to save it. Enter a name for the Clicker Set, choose where you wish to save it, and click Save.

The next time you save this Clicker Set, it will update the file at this location (unless it is a template, see below). For further help with using this dialog box, see Browsing files and folders.

**Note:** If you want to save the Clicker Set somewhere else or with a different name, open the Clicker Set menu and select Save Clicker Set As.

---

**Saving as a template**

To save a Clicker Set as a template, choose Clicker Set Template from the Save as type drop-down list when saving your Clicker Set.

You will be asked where you want to save a Clicker Set Template every time you save it. This is useful if you’ve created an activity where students will make their own changes to a Clicker Set (such as a book making activity) as it means each student will be prompted to save a new version of the file.

You can include your template in the Templates section that appears when creating a new Clicker Set. When saving as a template, the Resources folder becomes visible in your Shared Clicker Files. Within this is the Clicker Set Templates folder - save new template files/folders here for them to appear in the Templates section.

**Managing Favorites**

A list of Favorites provides a quick way to open your most commonly used Clicker Sets.
This is accessible by clicking the ★ Favorites icon on the Document Toolbar and selecting the Favorites tab.

- To add an open Clicker Set to your list of favorites, click Add current Clicker Set to favorites.

- To remove any Clicker Set from your list of favorites, click Remove Clicker Set from favorites.

If you can’t see the Document Toolbar, you can access the same functions by opening the Clicker Set menu and hovering over Favorites. Your Favorites list also appears on the Quick Start window.

Tip: Favorites, along with user preferences, are saved per user. See Saving your preferences for further information.

Note: In the Options menu, you can click Clear Favorites & Recent Files to clear both these lists.

Managing Favorites

A list of Favorites provides a quick way to open your most commonly used Clicker Sets.
This is accessible by clicking the Favorites icon on the Document Toolbar and selecting the Favorites tab.

- To add an open Clicker Set to your list of favorites, click Add current Clicker Set to favorites.

- To remove any Clicker Set from your list of favorites, click Remove Clicker Set from favorites.

If you can’t see the Document Toolbar, you can access the same functions by opening the Clicker Set menu and hovering over Favorites. Your Favorites list also appears on the Quick Start window.

Tip: Favorites, along with user preferences, are saved per user. See Saving your preferences for further information.

Note: In the Options menu, you can click Clear Favorites & Recent Files to clear both these lists.

Creating a new Clicker Set

Creating a new Clicker Set

It is now quick and easy to create engaging Clicker activities. Clicker 6 introduces a suite of powerful and easy to understand wizards that enable you to generate detailed Clicker Sets in a matter of minutes.
To begin, you can either open the **Clicker Set** menu and select **New Clicker Set**, or click **Make a Clicker Set** from the **Quick Start** window.

This will display the **New Clicker Set** window, which shows the three main ways of creating a new Clicker Set:

- **Quick Grid Wizards** – let Clicker 6 automatically generate grids based on supplied text or pictures
- **Quick Page Wizards** – create reading/writing books and various page-based activities
- **Templates** – create a Clicker Set based on an existing template

You can specify the **language** of the new Clicker Set by making a selection from the drop-down menu at the bottom of the window. You can change this later in the **Language** tab of the **Clicker Set Properties**.

A Clicker Set’s language setting will override the current language in Clicker, and subsequently change various components such as the **Spellchecker**, **Predictor**, and **Speech**. These tools will load data files for the appropriate language if they are present, otherwise they will be disabled. See **Using different languages** for further information.

**Quick Wizards**

Quick Wizards
Printed Documentation

Clicker 6 introduces **Quick Wizards**, a series of wizards designed to help you create elaborate Clicker Sets with minimal time and effort. Supply the text or pictures that you wish to include and Clicker will generate suitable grids/pages with appropriate layouts based upon your submissions.

This enables you to focus on the content of a Clicker Set without needing to worry about the design. Additionally, it saves you plenty of time – it’s possible to create an entire Clicker Set within a minute!

**Quick Grid Wizards**

a) **Sentence Building** - generate sentence grids based on supplied text

b) **Word Bank** - create a bank of words to refer to

c) **Picture Bank** - create a bank of reference pictures

**Quick Page Wizards**

a) **Writing Book** - make an interactive Click & Edit book

b) **Listen & Say** - design a word/picture association activity

c) **Tell the Story** - create a narrated story book

d) **Talk About** - build a speaking activity about a particular subject

e) **Matching** - generate a word/picture/sound matching activity

**Quick Grid Wizards**

This wizard will generate a number of grids based on sentences that you supply.

Type text into the large text box on the left hand side. [Text within square brackets] will be placed into one cell. As you start to type, you will see the preview on the right update to show the generated layout that will be used on your grids. A new grid will be created for each new line of text.

In addition to typing, it is also possible to include existing sections of text for use with the wizard. If you have copied text from elsewhere, you can paste it into the text box by pressing **Ctrl-V** or clicking the **Paste** button located below and choosing **From clipboard**.

The **Paste** button will also allow you to paste the contents of the current Document and all text from the current Clicker Set (useful if you wish to create a different Clicker Set from an existing one).
You can edit the appearance of your text by using the tools at the bottom of the text box. Use the **bold** and *italicized* icons to make text **bold** and *italicized*. Click the **color** icon to choose the color of your text.

Highlight text by selecting it and clicking the **highlight** icon. Choose a color for both these tools by clicking their arrows and selecting one from the color palette. Clicker will use the color of a word’s highlighting for its cell color.

To specify whether students can view a model sentence, make a selection from the Model Sentence drop-down box. It can be displayed as a cell on the grid, in a separate pop-up, or be spoken by a **Speaker** icon.

To choose from several different layouts, click the Layout drop-down box. The preview will change accordingly.

More Options
Clicker can adjust the order of words within your grids for you. To enable this, click the **Words** drop-down box and make a selection. Check the checkbox to **Hide duplicate words**. If you select **In the order they appear in the sentence**, you can check **Use Forced Order** to allow only a sequential selection of cells to enforce sentence order. For more information, see [Imposing forced ordering](#).

To set the background color, select **Gradient** or **Solid Color**. To choose your color(s), select **Custom** and click the nearby colored box(es) to show a color palette.

To choose the font for the activity, choose a selection from the **Font** drop-down box.

**Word Bank**

A word bank is a specialized grid that acts as storage for students to keep words that they have learned, or are learning, so that they can refer to them as needed. When writing a Document, they can go to the word bank as they are writing or editing to check a spelling, or to find a keyword related to a subject.
Choose your desired type from the three that are listed in the **Grids** drop-down list on the right:

- **Alphabetic grids** - words will be sorted into a tabbed set of A-Z grids
- **Topic grids** - a grid will be created for each set of words, with a heading on each tab
- **One grid** - words will be placed onto a single grid with no tabs

Text can be typed into the large text box on the left. The words that you type will appear as cells in the preview word bank displayed on the right under their respective tabs. [Text within square brackets] will be placed into one cell. When creating a **Topic grid** word bank, the text box will contain italicised example text that demonstrates how to arrange your words. This will disappear when you start typing.

In addition to typing, it is also possible to include existing sections of text for use with the wizard. If you have copied text from elsewhere, you can paste it into the text box by pressing **Ctrl-V** or clicking the **Paste** button located below and choosing **From clipboard**.

The **Paste** button will also allow you to paste the contents of the **current Document** and all text from the **current Clicker Set** (useful if you wish to create a different Clicker Set from an existing one).
If you’ve pasted text, you may want to filter the words used in the word bank. This can be done by making a selection from the **Filter Words** drop-down box to filter out common English words – from **32** to **2000**. You can also filter words based on length – check the checkbox below and enter the minimum number of letters a word should have to be included in the word bank.

**More Options**

To set the background color, select **Gradient** or **Solid Color**. To choose your color(s), select **Custom** and click the nearby colored box(es) to show a color palette.

To choose the font for the activity, choose a selection from the **Font** drop-down box.

**Picture Bank**

A picture bank is similar to a word bank in that it is a specialized **grid** that acts as storage for students to keep pictures of things that they have learned, or are learning, so that they can refer to them as needed.
Click **Add Pictures** to launch a Picture Browser. Once you have browsed to your pictures (which can be located within a Media Library, the current Clicker Set or elsewhere on your computer), click a picture to **select** it. Clicking it again will **deselect** it. If you want to add all the pictures in a folder, click **Select All**. Click **Clear Selection** to unselect all pictures in a folder. Once you have selected your picture(s), click **Insert**.

To change how your pictures will be ordered, make a selection from the **Pictures** drop-down box. You can check **Show picture names** to include them alongside the pictures in their cells. You can give pictures different names by double-clicking their filename and typing a new one before pressing **Enter**.

To remove pictures after you’ve added them, select them and click **Remove Pictures**.

If you select Manual picture ordering, two **arrow** icons will appear next to the **Clear Selection** button. Select a picture and then use these buttons to change its positioning in the sequence.

To change how many pictures appear in each grid, use the **Layout** box to specify a number.

**Note:** You can also right-click a picture to rename, delete or reorder it.
To set the background color, select **Gradient** or **Solid Color**. To choose your color(s), select **Custom** and click the nearby colored box(es) to show a color palette.

To choose the font for the activity, choose a selection from the **Font** drop-down box.

**Quick Page Wizards**

**Writing Book**

This wizard will generate a series of pages to make an interactive Click & Edit book aimed at helping students with their writing.

**Writing Support**
You have the option of creating a pop-up containing words that students can refer to as they write. This will be accessible by clicking the 📝Word pop-up icon which will appear in the Click & Edit Toolbar.

Choose whether you want a single pop-up for the whole book, a pop-up for each page, or no pop-ups at all.

If you've chosen for one or more pop-ups to appear, you will be asked to supply a selection of words for them in the next page of the wizard. In addition to typing, it is also possible to include existing sections of text for use with the wizard. If you have copied text from elsewhere, you can paste it into the text box by pressing Ctrl-V or clicking the 📋Paste button located below and choosing From clipboard.

The 📋Paste button will also allow you to paste the contents of the current Document and all text from the current Clicker Set (useful if you wish to create a different Clicker Set from an existing one).

Picture Support

To choose how a user will add pictures to their book when clicking a cell, check the checkboxes available in Picture Support:

- **Browse for pictures on the computer or network** – shows a 📈Picture Palette icon
• **Paint pictures with the paint tools** – shows a 🖌️ Paint icon

• **Take photos with the webcam** – shows a 🕵️ Webcam icon

• **Choose from a picture pop-up** – a pop-up containing pictures will appear when the 📷 Open pop-up icon is clicked. If this item is chosen, you will supply the pictures for your pop-up in the next page of the wizard. For information on how to add pictures, please see *Listen & Say*.

**Sound and Page options**

![New Clicker Set - Create new Clicker Set - Writing book](image)

To choose how a user can use sound and speech in their book, check the checkboxes available in **Sound and Speech**. You can include a button that will **speak the text** content of the page’s text box, and a button that will allow a user to **record their voice**.

You can specify the **number of pages** in your Clicker Book by selecting a number from the drop-down box in **Pages**. Check **Add title page** to add an additional page with a title layout.

To choose a different layout for your pages, make a selection from the **Page Layout** drop-down box.
You have the option to enable some additional **Page tools** for use in Click & Edit. When checked, the tool will be shown in the Click & Edit Toolbar.

To set the background color, select **Gradient** or **Solid Color**. To choose your color(s), select **Custom** and click the nearby colored box(es) to show a color palette.

To choose the font for the activity, choose a selection from the **Font** drop-down box.

**Listen & Say**

This wizard will generate a series of **pages** to make an interactive book that will help students associate pictures with words, and vice versa.
Click **Add Pictures** to launch a **Picture Browser**. Once you have browsed to your pictures (which can be located within a Media Library, the current Clicker Set or elsewhere on your computer), click a picture to **select** it. Clicking it again will **deselect** it. If you want to add all the pictures in a folder, click **Select All**. Click **Clear Selection** to unselect all pictures in a folder. Once you have selected your picture(s), click **Insert**.

After you’ve added them, you can give your chosen pictures different names by double-clicking their filename and typing a new one before pressing **Enter**. Clicking the **Remove Pictures** button will cause selected pictures to disappear from the wizard.

To change how your pictures are ordered, use the two **arrow** icons next to the **Clear Selection** button. Select a picture and then use these buttons to change its positioning in the sequence.

Type some text into the **Title** text box in order for it to appear as a heading on the title page.

**Note**: You can also right-click a picture to rename, delete or reorder it.
To set the background color, select **Gradient** or **Solid Color**. To choose your color(s), select **Custom** and click the nearby colored box(es) to show a color palette.

To choose the font for the activity, choose a selection from the **Font** drop-down box.

**Tell the Story**

This wizard will generate a series of pages to make an interactive book that will help students to narrate a story.
Click 📄 Add Pictures to launch a Picture Browser. Once you have browsed to your pictures (which can be located within a Media Library, the current Clicker Set or elsewhere on your computer), click a picture to select it. Clicking it again will deselect it. If you want to add all the pictures in a folder, click Select All. Click Clear Selection to unselect all pictures in a folder. Once you have selected your picture(s), click Insert.

After you’ve added them, you can give your chosen pictures different names by double-clicking their filename and typing a new one before pressing Enter. Clicking the Remove Pictures button will cause selected pictures to disappear from the wizard.

To change how your pictures are ordered, use the two arrow icons next to the Clear Selection button. Select a picture and then use these buttons to change its positioning in the sequence.

Type some text into the Title text box in order for it to appear as a heading on the title page.

**Note:** You can also right-click a picture to rename, delete or reorder it.
To set the background color, select **Gradient** or **Solid Color**. To choose your color(s), select **Custom** and click the nearby colored box(es) to show a color palette.

To choose the font for the activity, choose a selection from the **Font** drop-down box.

**Talk About**

This wizard will generate a series of pages to make an interactive presentation that will give students the opportunity to speak about a particular subject.
Click Add Pictures to launch a Picture Browser. Once you have browsed to your pictures (which can be located within a Media Library, the current Clicker Set or elsewhere on your computer), click a picture to select it. Clicking it again will deselect it. If you want to add all the pictures in a folder, click Select All. Click Clear Selection to unselect all pictures in a folder. Once you have selected your picture(s), click Insert.

After you've added them, you can give your chosen pictures different names by double-clicking their filename and typing a new one before pressing Enter. Clicking the Remove Pictures button will cause selected pictures to disappear from the wizard.

To change how your pictures are ordered, use the two arrow icons next to the Clear Selection button. Select a picture and then use these buttons to change its positioning in the sequence.

Type some text into the Title text box in order for it to appear as a heading on the title page.

Note: You can also right-click a picture to rename, delete or reorder it.
To set the background color, select **Gradient** or **Solid Color**. To choose your color(s), select **Custom** and click the nearby colored box(es) to show a color palette.

To choose the font for the activity, choose a selection from the **Font** drop-down box.

**Matching**

This wizard allows you to easily generate a matching activity using a combination of pictures, words, and sounds.
First, choose how the **target** to be matched will appear by making a selection from the drop-down box:

- **Picture** – target will appear as an image only
- **Picture and Word** – target will appear as an image with its name displayed underneath
- **Word** – target will appear as a word only
- **Sound** – target will appear as a sound button which will speak the target’s name

Choose how the **choices** will appear by making a selection from the second drop-down box.

If you have selected **Picture** for any options, the next page of the wizard will ask you for pictures to include.
Click **Add Pictures** to launch a [Picture Browser](#). Once you have browsed to your pictures (which can be located within a [Media Library](#), the current Clicker Set or elsewhere on your computer), click a picture to **select** it. Clicking it again will **deselect** it. If you want to add all the pictures in a folder, click **Select All**. Click **Clear Selection** to unselect all pictures in a folder. Once you have selected your picture(s), click **Insert**.

After you've added them, you can give your chosen pictures different names by double-clicking their filename and typing a new one before pressing **Enter**. Clicking the **Remove Pictures** button will cause selected pictures to disappear from the wizard.

If you have chosen to only use a combination of **words** and **sounds**, you will be asked to provide some on the next page of the wizard. Type or paste your desired words into the large text box, being sure to avoid punctuation.

You can specify the number of choices per page by making a selection from the **Layout** drop-down box.

**Note:** You can also right-click a picture to rename, delete or reorder it.

More Options
To set the background color, select **Gradient** or **Solid Color**. To choose your color(s), select **Custom** and click the nearby colored box(es) to show a color palette.

To choose the font for the activity, choose a selection from the **Font** drop-down box.

**Templates**

*Creating from a template*

Click **Templates** to display a list that shows the types of template available. Click one to display a window with a large preview of the current template.
You can browse the folder tree shown on the right to preview other templates in other categories. Clicking once on a template will display its preview.

For each template, you can specify the number of grids or pages to be created. Checking Use tabs will display a tab for each grid or page along the left of the Grid Toolbar.

Depending on the template chosen, you are also given the opportunity to choose the number of rows and columns. Use their arrow buttons to adjust their values, or enter numbers manually in the relevant boxes.

More Options
To set the background color, select **Gradient** or **Solid Color**. To choose your color(s), select **Custom** and click the nearby colored box(es) to show a color palette.

To choose the font for the activity, choose a selection from the **Font** drop-down box.

**Note:** You can save your own templates to the Templates section. See [Saving a Clicker Set](#).

**About the templates**

When you create a Clicker Set, there are many templates to choose from:

- **Blanks** – choose a blank grid or page. These contain no objects at all and serve as a fresh canvas for your imagination and creativity to run wild!

- **Book Making** – these contain page templates for Painting, Reading and Writing books. Each of these is available in a landscape or portrait format. All of them feature a cover page, followed by pages that include navigational buttons, speaker buttons and [recording](#) buttons to record your voice. Some templates feature Click & Edit, and also include buttons that open pop-up picture/word banks along with other tools such as [Paint](#).

- **Picture Banks** – a picture bank is a specialized grid with large cells that acts as storage for students to keep pictures of things that they are learning, so that they can refer to them as needed.

- **Sentence Building** – these templates help students learn about sentence structure. The standard templates contain a number of cells and a period. A **model** word, phrase, or sentence can be useful to assist learners. When clicked, the model is spoken rather than written. There are templates that display a model sentence on a grid, in a pop-up, or instead have a speaker
button that speaks the text. Additionally, there are Forced Order templates which will only allow one cell to be selected at a time in a chronological order. This is useful for enforcing the correct syntax of a sentence.

All these templates come in a regular form, as well as one with a large cell for a picture

• Word Banks – a word bank is a specialized grid that acts as storage for students to keep words that they have learned, or are learning, so that they can refer to them as needed

• Writing Frames – these templates feature several long cells that are designed to hold entire sentences to act as a form of writing support. The 'Starters and Words' template also has space for several regular cells, which can be used in conjunction with a partial sentence.

Note: You can save your own templates to the Templates section. See Saving a Clicker Set.

Creating and editing a keyboard

Clicker is supplied with several ready-made on-screen keyboards. These include Qwerty, Alphabetical, and Frequency key arrangements, along with versions of each with additional cells to display Predictor results. To open an on-screen keyboard, see Using the on-screen keyboard.

It is possible to edit these existing keyboards to create personalized, or even completely new, on-screen keyboards for Clicker users.

With an on-screen keyboard open, click the Edit Clicker Set button in the bottom left corner to open the keyboard in Edit Mode.
You can then edit a keyboard in the same way as you would a grid or page. For more information, see Introduction to Edit Mode.

To save an open keyboard, open the Clicker Set menu and then:

- Select Save Keyboard to overwrite the existing keyboard
- Select Save Keyboard As to save the keyboard as a new file

The Save As dialog box will save to the default Clicker keyboard location by default

---

**Notes:** Keyboards are saved into the `_Resources\Clicker\Keyboards` folder within your Shared Clicker Files (this is not viewable in Clicker Explorer).

---

**Editing a Clicker Set**

**Introduction to Edit Mode**

The new and improved Edit Mode makes it easy for you to edit Clicker Sets. To access it, click the Edit Clicker Set button in the bottom left corner of the window, or open the Clicker Set menu and select Edit Clicker Set. Upon entering Edit Mode, the view changes to provide you with tools to edit the Clicker Set:
**Clicker Sets**

**Note:** If the **Edit Clicker Set** options appear grayed out, check that **Enable Edit Mode** is selected in the **Clicker Set** tab in **User Preferences**.

The current grid, page, or pop-up is shown in the Editing Area, which allows you to position and resize objects. The **Sidebar** is on the left of the screen and the **Editing Toolbar** is above the Editing Area. You can choose the grid, page, or pop-up you wish to edit by clicking its thumbnail in the Sidebar, or use the scrollbar on the right of the Editing Area.

To undo a change you have made to a Clicker Set, click the **Undo** icon on the Editing Toolbar, open the **Edit** menu and select **Undo**, or press **Ctrl-Z**. You can undo as many changes as you need to by repeating the action. To redo a change you have undone, click the **Redo** icon on the Editing Toolbar, open the **Edit** menu and select **Redo**, or press **Ctrl-Y**.

To leave Edit Mode, open the **Clicker Set** menu and select **Edit Clicker Set**, or click the **Edit Clicker Set** button in the status bar at the bottom left corner of the Clicker window.

**The Editing Toolbar**
The **Editing Toolbar** contains tools for editing the currently selected object(s). Its content will vary depending on what type of object is selected. The tools are separated onto different tabs according to their functionality:

![Editing Toolbar](image)

- **Appearance** – color, font, and picture options for objects
- **Send** – define what an object will send when clicked
- **Sound & Video** – set an object to play sound and video when clicked with the left/right mouse button
- **Open** – choose what an object will open when clicked
- **Arrange** - adjust the layout of cells in a cluster
- **Click & Edit** – define which tools appear for an object when using Click & Edit

If no objects are selected, the toolbar will show tools for editing the current grid, page, or pop-up itself.

- **Appearance** – background options and setting grid height
- **Sound & Video** – have a sound or video play when opening or closing it
- **Arrange** - adjust how objects are laid out on it

**Tip:** Hold your mouse over a tool to read a short description of its function.

---

**The Sidebar**

The Sidebar contains four tabs which allow you to do different things:
Clicker Sets

- **Outline** – view, create, delete, and arrange grids, pages, and pop-ups in the Clicker Set

- **Media** – browse and search your Media Libraries and computer for pictures, sounds, and videos to use in the Clicker Set

- **Objects** – add objects such as buttons and cells to your grids, pages, and pop-ups

- **Scan** – configure scan groups for a grid, page, or pop-up

You can extend or retract the Sidebar to make the Editing Area bigger or smaller:

1. Move the mouse pointer to the right edge of the Sidebar so the mouse pointer becomes a **double-headed arrow**

2. Click and drag the double-headed arrow left or right to decrease or increase the width of the Sidebar

### Changing text in cells

You can change the text in a cell by holding down the **Shift** key and **left-clicking** the cell with the mouse. Type into the cell and press **Enter** when finished. It is possible to move straight to the next cell by pressing **Tab** instead. You can also edit and move between cells inside a cluster with this method.

You can also quickly edit **text boxes** using this method.
Pictures from your Media Libraries may appear automatically in cells as you edit the text, as a result of the Instant Pictures feature. To turn Instant Pictures in cells on or off, see the Media tab in Clicker Set Properties.

Tip: You can use Shift-click to edit the text in cells at any time. If you want to make more advanced changes to a Clicker Set, see Editing a Clicker Set.

 Editing grids, pages and pop-ups
 Using the Objects tab

The Objects tab in the Sidebar lets you add various objects to your Clicker Sets by dragging them onto the grid, page, or pop-up.

Select a palette from the drop-down list to display different styles of object.

The palettes contain different types of objects:
**Clicker Sets**

• **Buttons**: contains buttons such as forward/backward arrows. Some have predefined actions (e.g., open the Sound Recorder); others can be configured after they are added.

• **Cells**: these display text and pictures and can be customized to perform actions and play sounds.

• **Clusters**: are groups of cells arranged in rows and columns which are used to display banks of words or pictures.

• **Text boxes**: are used to display long sections of text that can be formatted just like a Document.

**Adding and deleting objects**

To add an object to a grid, page, or pop-up in Edit Mode, click and drag your chosen object to the desired location in the Editing Area. After the mouse button is released, the object will appear on the grid, page, or pop-up. You can then manipulate the object by positioning or resizing.

To delete an object on a grid, page, or pop-up in Edit Mode, select it and then press the Delete key on your keyboard. Alternatively, you can open the Edit menu and select Delete, or right-click the object and select Delete.

**Note**: To add/delete cells in a cluster, see Adding/deleting cells. To delete a text box, see Using text boxes.

**Tip**: You can also copy existing objects to create new ones.
Selecting objects

To select an object on a grid, page, or pop-up in Edit Mode, simply click on it. Box handles appear round the object to show it is selected.

To select multiple objects, click on the background of the grid, page, or pop-up and drag your selection box over the objects. Alternatively, hold Ctrl and click the objects one at a time (Ctrl-clicking a selected object will deselect it).

You can quickly select all the objects on a grid, page, or pop-up by opening the Arrange tab and clicking the Select All icon. Alternatively, open the Edit menu and select Select All Cells. To deselect all the objects, click the background of the grid, page, or pop-up.

If selecting more than one object, the last object selected is the active object, and will be used as the basis for aligning and resizing the other selected cells.

Note: To select cells in a cluster, see Selecting cells.

Positioning and aligning objects

To position an object on a grid, page, or pop-up in Edit Mode, click and drag your chosen object to the desired location in the Editing Area. The object shape follows your mouse cursor. After the mouse button is released, the object will remain in its new position.

When you drag objects to position them, they move in increments to help make your grids neater. To change the minimum amount of pixels an item shifts when moved, see Changing Snap to Position.

Note: You can also move objects to another grid, page, or pop-up.

You can line up objects on a grid, page or pop-up in Edit Mode by their edges or center points, and distribute them so that the distance between them is the same.

To align or distribute objects, first select the objects you want to align or distribute and then either:
• Open the **Arrange** tab on the **Editing Toolbar**, click the ![Align and Distribute](image) icon and select an option.

• Right-click on one of the objects, hover over **Align** or **Distribute**, and then select an option.

If you are aligning the objects, the objects are aligned to the **active** object (last one selected)

**Tip:** To arrange cells in rows and columns, you can use a **cell cluster**.

---

**Resizing objects**

To resize an **object** on a grid, page or pop-up in **Edit Mode**, drag one of the box handles located on a corner or edge of the object:

1. Select the object you want to resize.

2. Click one of the box handles on the corner or edge of the object and drag the mouse cursor.

3. The object shape follows your mouse cursor. After the mouse button is released, the object will remain at its new size.

To resize **multiple** objects on a grid, page, or pop-up **simultaneously** in Edit Mode, first select the objects you want to resize, then click and drag any one of the selected objects' box handles. This will cause all the items to be resized simultaneously.

Alternatively, hold **Ctrl-Alt**. This will cause all cells to be treated as a single item (there will only be one set of box handles). Use these box handles to resize the group as if it were a single object.

When you drag an object’s box handles to resize it, it will resize in increments to help make your grids neater. To change the amount an object resizes per increment, see **Changing Snap to Position**.

---

**Making objects the same size, width, or height**

In addition to resizing manually, you can also resize several objects on a grid, page or pop-up in Edit Mode at once so they are the same size as the **active** object (the last one selected).

To make objects the same size, select the objects you want to resize and then either:

• Open the **Arrange** tab on the **Editing Toolbar**, click on the ![Make Same](image) icon and then select an option
Moving and copying objects

Move objects around the grid, page, or pop-up by clicking and dragging them to your desired location.

You can also move and copy selected objects using the Copy, Cut, and Paste functions, which are located in the Arrange tab on the Editing Toolbar, an object’s right-click menu, or you can use your keyboard.

• **Copy** – the 🔄 icon, Copy in the right-click menu, or press Ctrl-C

• **Cut** – the 🗑 icon, Cut in the right-click menu, or press Ctrl-X

• **Paste** – the 📚 icon, Paste in the right-click menu, or press Ctrl-P

Using Copy on selected objects will copy it to the clipboard, which is a temporary storage area on your computer. If Cut is used on selected objects, it will do this and also delete the original.

You can then use Paste to insert the clipboard objects to your chosen location, which can be on a different grid, page, or pop-up if you wish.

Using a combination of Cut and Paste will effectively move an object from one location to another.

**Changing Snap to Position**

Snap to Position helps to make your grids, pages, and pop-ups neater by making objects move and resize in increments in Edit Mode. For example, dragging an object will make it move a number of pixels at a time instead of just one.

Open the Arrange tab on the Editing Toolbar and click the 🕵️ Snap to Position icon to see the available options.

To turn Snap to Position off, uncheck the Ensure objects are regularly spaced checkbox. To change the size of the grid spacing, click Change grid spacing.
Use the arrow buttons, or enter numbers, to determine the horizontal and vertical spacing in pixels.

Layering objects

If objects overlap, you can bring an object forward to the front so it appears above other objects, or send it to the back so it appears behind other objects.

To change the layering of an object in Edit Mode, select the object you wish to move, open the Arrange tab on the Editing Toolbar, and click the Bring to Front or Send to Back icon.

Alternatively, you can right-click a selected object and select the same options from the menu.

Note: Text boxes will always appear in front of other objects.

Changing the background

To change the background of a grid, page, or pop-up in Edit Mode, first ensure that no objects are selected by clicking on the background and then open the Appearance tab on the Editing Toolbar.

You can show a solid color on the background by clicking the Gradient button, selecting No Gradient, and then clicking Color to select a color.

Alternatively, to show a gradient on the background, click the Gradient button and make a selection from the drop-down menu. Click Color and Additional Color to select the colors for the gradient from a color palette.

To show a picture on the background of a grid, page, or pop-up, click the Picture button and select an option:

• To browse your computer and Media Libraries for a picture, select Browse.

For further help, see Using Media Browsers

• To paint a picture, select Paint. For further help, see Painting a picture
To take a photo using your webcam, select Webcam. For further help, see Taking a webcam photo.

To remove a picture from the background, click the Remove Picture button.

Background positioning

To change how a background picture is displayed, click the Position button and select an option:

- **Stretch** - stretch the picture to cover the whole background
- **Fit** – resize the picture and display it in the center of the background
- **Center** – display the picture in the centre of the background but don’t resize it
- **Tile** – repeat the picture to cover the background
- **Scaled Tile** – repeat the picture to cover the background using the same number of tiles when the grid is resized. Use this to ensure objects always line up with the tiles

Transition sound effects

You can specify a sound to be played during the opening and/or closing of a grid, page, or pop-up. With no objects selected, open the Sound & Video tab on the Editing Toolbar.

On this tab, a box indicates what is currently assigned to the opening/closing sounds for that grid, page, or pop-up. To hear a preview of a sound, click the Speaker icon.

The Choose button towards the right of the box displays a drop-down menu with several choices:

- **Speak text** – speaks the text you specify using Clicker’s speech engine. Click Insert to link to text in other objects in the Clicker Set
• **Play Sound or Video** – this will play a sound from your computer, or allow you to record one

To play an existing sound, click ✉️ **Browse**, navigate to your chosen file, select it, and click **Insert**.

To **record** your own sound, click 🎨 **Record**

A list of used and recorded sound files is kept within the **Play Sound or Video** sub-menu

• **No Sound or Video** – nothing is played when opening/closing the grid, page, or pop-up

There is a checkbox in the **Closing** sound section that will stop the grid from closing until the sound has finished playing.

**Note:** Grids/pages within **tabbed sequences** will display options for **left-click/right-click** rather than **opening/closing** as their tabs are clicked to open them. See **Playing sound**.

**Tip:** A folder containing all pictures, sound and video used in the current Clicker Set is accessible from the **Media tab**.

**Transition video effects**

It is possible for a specified video clip to be played during the opening and/or closing of a grid, page, or pop-up. With no objects selected, open the **Sound & Video** tab on the **Editing Toolbar**.

On this tab, a box indicates what item is currently assigned to be played when opening and closing that the current grid, page, or pop-up. To see a preview of a video, click the ➡️ **Play** icon.

The **Choose** button towards the right of the box displays a drop-down menu with several choices:
• **Play Sound or Video** – this will play a video clip from your computer

To play an existing video, click **Browse**, navigate to your chosen file, select it, and click **Insert**.

A list of used video files is kept within the **Play Sound or Video** sub-menu

• **No Sound or Video** – nothing is played when opening/closing the grid, page, or pop-up

There is a checkbox in the **Closing** sound section that will stop the grid from closing until the video has finished playing.

When a video is selected for either the opening or closing action, a **Video Details** button will appear near the bottom of the appropriate section of the toolbar. Click this to choose how the video will be displayed from a list of options in a drop-down list:

- In the cell
- Scaled to half the size of the grid
- Scaled to the grid
- Filling the screen

Additionally, you can also choose whether you want the video to maintain it's original shape, or stretch to fill the available space.

**Note**: Grids/pages within **tabbed sequences** will display options for **left-click/right-click** rather than **opening/closing** as their tabs are clicked to open them. See **Playing video**.

**Tip**: A folder containing all pictures, sound and video used in the current Clicker Set is accessible from the **Media tab**.

**Reordering cells**

When a grid, page, or pop-up opens, Clicker can order specific cells alphabetically according to their contents, or it can sort them randomly each time.

Firstly, select one or more cells, open the **Arrange** tab on the **Editing Toolbar**, click **More Options** and check **Allow this cell to be sorted**.

To choose how these cells will be sorted, open the **Arrange** tab with no objects selected, click **More Options** and make a selection from the drop-down list.
To sort the contents of a cell cluster, see Sorting cluster contents.

Setting the height of a grid

You can set the height of a grid so that it is the same whenever the grid is used.

To set the grid height in Edit Mode, first ensure that no objects are selected by clicking on the background and then open the Appearance tab on the Editing Toolbar.

Click More Options and check the box next to Remember grid height. Use the arrows buttons to increase or decrease the percentage of the window used by the grid, or enter a number into the box.

Tip: You can also temporarily change the height of a grid while you are using it.

Note: You can’t set the height of a page as it always uses the full size of the window. To change the size of a pop-up, see Using Pop-ups.

Editing grids, pages, and pop-ups

Using the Objects tab

The Objects tab in the Sidebar lets you add various objects to your Clicker Sets by dragging them onto the grid, page, or pop-up.

Select a palette from the drop-down list to display different styles of object.

The palettes contain different types of objects:
• **Buttons**: contains buttons such as forward/backward arrows. Some have predefined actions (e.g., open the Sound Recorder); others can be configured after they are added.

• **Cells**: these display text and pictures and can be customized to perform actions and play sounds.

• **Clusters**: are groups of cells arranged in rows and columns which are used to display banks of words or pictures.

• **Text boxes**: are used to display long sections of text that can be formatted just like a Document.

---

**Adding and deleting objects**

To add an object to a grid, page, or pop-up in Edit Mode, click and drag your chosen object to the desired location in the Editing Area. After the mouse button is released, the object will appear on the grid, page, or pop-up. You can then manipulate the object by positioning or resizing.

To delete an object on a grid, page, or pop-up in Edit Mode, select it and then press the Delete key on your keyboard. Alternatively, you can open the Edit menu and select Delete, or right-click the object and select Delete.

**Note**: To add/delete cells in a cluster, see Adding/deleting cells. To delete a text box, see Using text boxes.

**Tip**: You can also copy existing objects to create new ones.
Selecting objects

To select an object on a grid, page, or pop-up in Edit Mode, simply click on it. Box handles appear round the object to show it is selected.

![Illustration of a selected object]

To select multiple objects, click on the background of the grid, page, or pop-up and drag your selection box over the objects. Alternatively, hold Ctrl and click the objects one at a time (Ctrl-clicking a selected object will deselect it).

You can quickly select all the objects on a grid, page, or pop-up by opening the Arrange tab and clicking the Select All icon. Alternatively, open the Edit menu and select Select All Cells. To deselect all the objects, click the background of the grid, page, or pop-up.

If selecting more than one object, the last object selected is the active object, and will be used as the basis for aligning and resizing the other selected cells.

Note: To select cells in a cluster, see Selecting cells.

Positioning and aligning objects

To position an object on a grid, page, or pop-up in Edit Mode, click and drag your chosen object to the desired location in the Editing Area. The object shape follows your mouse cursor. After the mouse button is released, the object will remain in its new position.

When you drag objects to position them, they move in increments to help make your grids neater. To change the minimum amount of pixels an item shifts when moved, see Changing Snap to Position.

Note: You can also move objects to another grid, page, or pop-up.

You can line up objects on a grid, page or pop-up in Edit Mode by their edges or center points, and distribute them so that the distance between them is the same.

To align or distribute objects, first select the objects you want to align or distribute and then either:
• Open the **Arrange** tab on the **Editing Toolbar**, click the **Align and Distribute** icon and select an option.

• Right-click on one of the objects, hover over **Align** or **Distribute**, and then select an option.

If you are aligning the objects, the objects are aligned to the **active** object (last one selected)

**Tip:** To arrange cells in rows and columns, you can use a **cell cluster**.

---

**Resizing objects**

To resize an **object** on a grid, page, or pop-up in **Edit Mode**, drag one of the box handles located on a corner or edge of the object:

1. **Select** the object you want to resize.
2. Click one of the box handles on the corner or edge of the object and drag the mouse cursor.
3. The object shape follows your mouse cursor. After the mouse button is released, the object will remain at its new size.

To resize **multiple** objects on a grid, page, or pop-up **simultaneously** in Edit Mode, first select the objects you want to resize, then click and drag any one of the selected objects’ box handles. This will cause all the items to be resized simultaneously.

Alternatively, hold **Ctrl-Alt**. This will cause all cells to be treated as a single item (there will only be one set of box handles). Use these box handles to resize the group as if it were a single object.

When you drag an object’s box handles to resize it, it will resize in increments to help make your grids neater. To change the amount an object resizes per increment, see **Changing Snap to Position**.

**Making objects the same size, width, or height**

In addition to resizing manually, you can also resize several objects on a grid, page, or pop-up in Edit Mode at once so they are the same size as the **active** object (the last one selected).

To make objects the same size, select the objects you want to resize and then either:

• Open the **Arrange** tab on the **Editing Toolbar**, click on the **Make Same** icon and then select an option.
• **Right-click** on the object with the correct size, select **Make Same**, and then select an option

**Moving and copying objects**

Move objects around the grid, page, or pop-up by clicking and dragging them to your desired location.

You can also move and copy **selected objects** using the **Copy**, **Cut**, and **Paste** functions, which are located in the **Arrange** tab on the **Editing Toolbar**, an object’s right-click menu, or you can use your keyboard.

- **Copy** – the icon, **Copy** in the right-click menu, or press **Ctrl-C**
- **Cut** – the icon, **Cut** in the right-click menu, or press **Ctrl-X**
- **Paste** – the icon, **Paste** in the right-click menu, or press **Ctrl-P**

Using **Copy** on selected objects will copy it to the clipboard, which is a temporary storage area on your computer. If **Cut** is used on selected objects, it will do this and also delete the original.

You can then use **Paste** to insert the clipboard objects to your chosen location, which can be on a different grid, page, or pop-up if you wish.

Using a combination of **Cut** and **Paste** will effectively **move** an object from one location to another.

**Changing Snap to Position**

**Snap to Position** helps to make your grids, pages, and pop-ups neater by making **objects move** and **resize** in increments in **Edit Mode**. For example, dragging an object will make it move a number of pixels at a time instead of just one.

Open the **Arrange** tab on the **Editing Toolbar** and click the **Snap to Position** icon to see the available options.

To turn **Snap to Position** off, uncheck the **Ensure objects are regularly spaced** checkbox. To change the size of the grid spacing, click **Change grid spacing**.
Use the arrow buttons, or enter numbers, to determine the horizontal and vertical spacing in pixels.

Layering objects

If objects overlap, you can bring an object forward to the front so it appears above other objects, or send it to the back so it appears behind other objects.

To change the layering of an object in Edit Mode, select the object you wish to move, open the Arrange tab on the Editing Toolbar, and click the Bring to Front or Send to Back icon.

Alternatively, you can right-click a selected object and select the same options from the menu.

**Note:** Text boxes will always appear in front of other objects.

Changing the background

To change the background of a grid, page, or pop-up in Edit Mode, first ensure that no objects are selected by clicking on the background and then open the Appearance tab on the Editing Toolbar.

You can show a solid color on the background by clicking the Gradient button, selecting No Gradient, and then clicking Color to select a color.

Alternatively, to show a gradient on the background, click the Gradient button and make a selection from the drop-down menu. Click Color and Additional Color to select the colors for the gradient from a color palette.

To show a picture on the background of a grid, page, or pop-up, click the Picture button and select an option:

- To browse your computer and Media Libraries for a picture, select Browse.

For further help, see Using Media Browsers

- To paint a picture, select Paint. For further help, see Painting a picture
Clicker Sets

• To take a photo using your webcam, select Webcam. For further help, see Taking a webcam photo.

To remove a picture from the background, click the Remove Picture button.

Background positioning

To change how a background picture is displayed, click the Position button and select an option:

• Stretch - stretch the picture to cover the whole background
• Fit – resize the picture and display it in the center of the background
• Center – display the picture in the centre of the background but don’t resize it
• Tile – repeat the picture to cover the background
• Scaled Tile – repeat the picture to cover the background using the same number of tiles when the grid is resized. Use this to ensure objects always line up with the tiles

Transition sound effects

You can specify a sound to be played during the opening and/or closing of a grid, page, or pop-up. With no objects selected, open the Sound & Video tab on the Editing Toolbar.

On this tab, a box indicates what is currently assigned to the opening/closing sounds for that grid, page, or pop-up. To hear a preview of a sound, click the Speaker icon.

The Choose button towards the right of the box displays a drop-down menu with several choices:

• Speak text – speaks the text you specify using Clicker’s speech engine. Click Insert to link to text in other objects in the Clicker Set
• **Play Sound or Video** – this will play a sound from your computer, or allow you to record one

To play an existing sound, click **Browse**, navigate to your chosen file, select it, and click **Insert**.

To **record** your own sound, click **Record**

A list of used and recorded sound files is kept within the **Play Sound or Video** sub-menu

• **No Sound or Video** – nothing is played when opening/closing the grid, page, or pop-up

There is a checkbox in the **Closing** sound section that will stop the grid from closing until the sound has finished playing.

---

**Note:** Grids/pages within tabbed sequences will display options for **left-click/right-click** rather than opening/closing as their tabs are clicked to open them. See **Playing sound**.

---

**Tip:** A folder containing all pictures, sound and video used in the current Clicker Set is accessible from the **Media tab**.

---

**Transition video effects**

It is possible for a specified video clip to be played during the opening and/or closing of a grid, page, or pop-up. With no objects selected, open the **Sound & Video** tab on the **Editing Toolbar**.

On this tab, a box indicates what item is currently assigned to be played when opening and closing that the current grid, page, or pop-up. To see a preview of a video, click the **Play** icon.

The **Choose** button towards the right of the box displays a drop-down menu with several choices:
Clicker Sets

- **Play Sound or Video** – this will play a video clip from your computer

  To play an existing video, click **Browse**, navigate to your chosen file, select it, and click **Insert**.

  A list of used video files is kept within the **Play Sound or Video** sub-menu

- **No Sound or Video** – nothing is played when opening/closing the grid, page, or pop-up

There is a checkbox in the **Closing** sound section that will stop the grid from closing until the video has finished playing.

When a video is selected for either the opening or closing action, a **Video Details** button will appear near the bottom of the appropriate section of the toolbar. Click this to choose how the video will be displayed from a list of options in a drop-down list:

- In the cell
- Scaled to half the size of the grid
- Scaled to the grid
- Filling the screen

Additionally, you can also choose whether you want the video to **maintain it’s original shape**, or **stretch to fill the available space**.

---

**Note**: Grids/pages within **tabbed sequences** will display options for **left-click/right-click** rather than **opening/closing** as their tabs are clicked to open them. See **Playing video**.

---

**Tip**: A folder containing all pictures, sound and video used in the current Clicker Set is accessible from the **Media tab**.

---

**Reordering cells**

When a grid, page, or pop-up opens, Clicker can order specific cells alphabetically according to their contents, or it can sort them randomly each time.

Firstly, select one or more cells, open the **Arrange** tab on the **Editing Toolbar**, click **More Options** and check **Allow this cell to be sorted**.

To choose how these cells will be sorted, open the **Arrange** tab with no objects selected, click **More Options** and make a selection from the drop-down list.
To sort the contents of a cell cluster, see Sorting cluster contents.

**Setting the height of a grid**

You can set the height of a grid so that it is the same whenever the grid is used.

To set the grid height in **Edit Mode**, first ensure that no objects are selected by clicking on the background and then open the **Appearance** tab on the **Editing Toolbar**.

Click **More Options** and check the box next to **Remember grid height**. Use the arrows buttons to increase or decrease the percentage of the window used by the grid, or enter a number into the box.

**Tip:** You can also temporarily change the height of a grid while you are using it.

**Note:** You can’t set the height of a page as it always uses the full size of the window. To change the size of a pop-up, see Using Pop-ups.

**Using clusters**

**Using clusters**

A cluster is a group of cells that are arranged in rows and columns.

This allows for multiple cells to be manipulated together without breaking their formation, a feature that is useful for such things as creating a bank of words/pictures or sentence building activities. A cluster appears in the **Objects** tab in the **Sidebar** when in **Edit Mode**.

You can manipulate cells in a cluster in the same way you would if they were not clustered. For example, you can enter text into cells within a cluster by holding **Shift** and clicking one. You can then press **Tab** to enter text into the next one, and so on.

To add a cluster to a grid, page, or pop-up, drag it from the **Objects** tab. For more information, see Adding and deleting objects.
Selecting clusters and their cells

Click a cell in a cluster to select it. If you hold down the Ctrl key while clicking, you can select multiple cells at the same time. Selected cells will become highlighted to reflect their status.

To deselect a cell, hold down the Ctrl key and click the highlighted cell. To deselect all cells, click anywhere in the background of the grid, page or pop-up.

Selecting clusters themselves

Although you cannot select a cluster in the same way as you would another object, you can access various cluster options by right-clicking on any cell contained within it and hovering over Cluster at the bottom of the menu.

Adding and deleting cells in a cluster

To insert a row or column of cells to a cluster, select a cell within the cluster and open the Arrange tab in the Editing Toolbar. Click the Insert button and select Row or Column. The row or column is added relative to that cell.

Additionally, you also have the option of adding a new cell from the Insert button. This will be placed below the selected cell.
To delete a row or column from a cluster, select a cell in the row or column you want to delete and open the **Arrange** tab. Click the **Delete** button and choose an option from the drop-down menu. You have the option of deleting the selected cell itself.

You can also delete a cell by selecting it, right-clicking it, and selecting **Delete Cell**.

---

**Tip:** Instead of deleting cells, you can make empty cells invisible. See [Changing empty cell visibility](#).

---

**Changing column widths of a cluster**

You can change the width of a column in a cluster by positioning the mouse pointer between two columns so that a bar appears and then click and drag the bar to the left or right.

To make all columns the same width, right-click a cell in the cluster, hover over **Cluster**, and select **Distribute Columns Evenly**.

**Changing cell alignment in a cluster**

When a column has fewer cells in it than others in the cluster, you can specify how it is positioned in the empty space left by a deleted cell.

Select a cell from that column, then open the **Arrange** tab on the **Editing Toolbar**, click the **Column Alignment** button, and make a selection from the drop-down menu.
Merging cells in a cluster

You can merge adjacent cells in the same row into a single wider one, as well as split cells that have been merged previously.

To do this, select the relevant cells, open the Arrange tab on the Editing Toolbar, click the Merge Cells button, and then select the option to merge or split from the drop-down menu.

You can also do this by right-clicking the relevant cells and choosing Merge Cells or Split Cell accordingly.

Changing cell spacing in a cluster

You can change the space between cells in a cluster so that they’re tightly packed together or loosely assembled.

To do this, select a cell from the cluster, open the Arrange tab on the Editing Toolbar, click the Cell Spacing button, and select a size from the drop-down menu. There are three options: Small, Medium, and Large.

Setting empty cell visibility in a cluster

You can make empty cells invisible by selecting a cell from the cluster, clicking the Empty Cells button on the Arrange tab on the Editing Toolbar, and deselecting Show Empty Cells.
Cells will appear translucent in Edit Mode (as pictured), to help you find them again!

Selecting Show Empty Cells will make empty cells become visible again.

**Sorting cluster contents**

You can sort cells in a cluster alphabetically or in a random order.

To do this, select a cell from the cluster, open the Arrange tab on the Editing Toolbar, select the AZ Sort Order button, and make a selection from the drop-down menu.

If you change some words in the cluster, you can click Sort Now to quickly sort according to your chosen order.

**Imposing forced ordering**

With Forced Ordering enabled, only the first column of the cluster is initially clickable. Other columns are grayed out and inactive. Once a selection is made from the first column, the next column becomes the only active one, and so on. This is useful to help teach things such as sentence structure.

To enable Forced Ordering, select a cell from the cluster, open the Arrange tab on the Editing Toolbar, click the Forced Order button, and select Use Forced Order. Repeat this to disable it.

**Disassembling a cluster**

If you no longer wish for all the cells in a cluster to be grouped together, you can "uncluster" them by right-clicking a cell in the cluster, hovering over Cluster, and selecting Uncluster Cells.
Like any action in Edit Mode, this can be reversed by clicking the **Undo** icon in the top-right corner of the **Editing Toolbar**. However, it is not possible to create a new cluster from a existing group of cells.

### Using text boxes

Text boxes are similar to cells, but are useful if you want a piece of text with words or phrases formatted in different ways together (such as using different fonts or sizes).

They can also be used for user text input when featured in pages that use **Click and Edit**.

To add a text box to a grid, page, or pop-up, drag it from the **Objects** tab. To delete a text box, click it to select it, then right-click one of its box handles and choose **Delete** from the menu.

See **Text box properties** to learn how to customize text boxes and their content.

### Adding content to text boxes

In **Edit Mode**, click a text box to select it, then click again to start writing in it. A blinking text cursor appears to show that you can start typing. Additionally, you can **copy** text from another application (such as Microsoft Word or Internet Explorer), and **paste** it into the text box using the buttons in it's **Appearance** tab. Outside of Edit Mode, text can be quickly edited by holding the **Shift** key and clicking the text box, the **same as a cell**.

A pop-up can be configured to send content to a text box. For more information, see **Show a pop-up**.

Text boxes offer a great way for students to enter text in Click & Edit sets. Not only can they be assisted by customizable word pop-ups and the **Predictor** feature, they can copy/paste text, check their spelling, undo/redo, and hear their text spoken. For more information, see **How to use Click & Edit**.

---

**Note:** If **Instant Pictures** are enabled for Documents, they will also appear in text boxes.
Text box properties

When you click a text box in Edit Mode, its Appearance tab appears in the Editing Toolbar. This enables you to specify a number of different properties that affect the appearance of the text box, in addition to its content.

Changing border and color

To change a text box's background color, click the Color icon and select your choice from the drop-down color palette.

To change the border color of a text box, click the Border icon on the Appearance tab and select a choice from the drop-down color palette.

You can set your preferred thickness of the border by hovering over Thickness near the bottom of the drop-down color palette and selecting an option from the sub-menu.

To change the style of the border, hover over Style at the bottom of the drop-down color palette and select an option from the sub-menu.

Insert a picture

Click the Picture button to launch a Picture Browser. Navigate to a picture file on your computer or in a registered Media Library. When you have browsed to your desired picture, click Insert and the picture will appear in your text box.

You can then position and resize it as you would in a Document. To remove it, click it to show its bounding box and press the Delete key.

Format text
To set the font style and size (for new, or selected text), make a selection from the drop-down lists.

There are three icons that will make text **bold**, *italicized* and *underlined* respectively when clicked.

To set the color of the text, click the คอนโด Text Color คอนโด button and select a choice from the drop-down color palette.

To highlight text, select some text and click the คอนโด Highlight คอนโด icon. To use a different highlight color, click on the arrow to the right of the icon and choose one from the drop-down color palette.

**Changing the layout of text**

**Align** text to the left, center or right of the text box by clicking the คอนโด Alignment คอนโด icon and selecting an option.

To start new paragraphs with **numbers** click the คอนโด Numbering คอนโด icon. To start new paragraphs with **bullet points**, click the คอนโด Bullets คอนโด icon. Click the icons again to disable them.

To change the **spacing** between lines of text, click the คอนโด Line Spacing คอนโด icon and select a spacing option.

**Moving/copying text**

You can move or copy selected text by clicking the คอนโด Copy คอนโด, คอนโด Cut คอนโด, and คอนโด Paste คอนโด icons.

**Copy** will copy selected text to the clipboard (a temporary storage area). Using **Cut** will do this and also delete the original text. You can then use **Paste** to insert the clipboard text to your chosen location.

**Spellchecking text**

To check the spelling in a text box, click the คอนโด Spellcheck คอนโด icon.

**Spellchecking a Clicker Set**

To check the spelling of words in a Clicker Set in **Edit Mode**, click the คำตอบ Spellcheck Clicker Set คำตอบ icon near the top right corner of the Editing Toolbar, or open the Edit menu and select **Spellcheck Clicker Set**.
Note: Clicker will automatically use the Spellchecker for the language of the Clicker Set. If you cannot spellcheck a Clicker Set, it is because no Spellchecker is available for the language you are using.

The Spellchecker looks through the objects in the Clicker Set for words that are not in its dictionary. If it finds a word it does not recognize, it highlights the object containing the word and offers alternative spellings.

To leave the spelling as it is, click one of these buttons:

- **Ignore Once** – leaves the spelling as it is, but only in the context shown
- **Ignore All** – leaves the spelling as it is and ignores all other occurrences of it in the current Clicker Set

To change the spelling, first select the suggested spelling you want in the bottom box, or type your correction in the top box. Then click one of these buttons:

- **Change** – changes the spelling only once, in the context shown
- **Change All** – changes the spelling for all occurrences of the misspelling in the current Clicker Set
The Spellchecker then continues looking through the Clicker Set for further misspellings.

**Tip:** Spelling is also checked in text boxes, with misspelled words underlined in red. You can right-click these words to select from a list of alternative spellings. Clicker can automatically capitalize the start of sentences and names in text boxes.

---

**Changing object properties**

**Changing object properties**

The Editing Toolbar allows you to edit various aspects of the objects on your grid, page, or pop-up, as well as providing you with a wealth of different ways to add interesting functionality.

To change the properties of one or more objects, select them and then use the Editing Toolbar to make your changes. Click here to discover how to select individual cells within a cluster.

Some things you can do with the Editing Toolbar are:

- Change the appearance of an object
- Customize what an object sends to the Document
- Add sound and video to an object
- Use an object to open another grid, a pop-up keyboard, or a webpage
- Use an object to record sound, take a photo, or open Paint
- Arrange and synchronize the positioning and dimensions of multiple objects
- Change the shape of the mouse pointer when over an object

**Note:** The properties and functions available will vary depending on the type of object selected.

**Tip:** You can hover over any icon on the Editing Toolbar to learn what it does from the displayed tooltip.

---

**Altering object appearance**
Altering object appearance

All articles in this section use the Appearance Tab:

Click the links below to find out more about:

- Changing border and color
- Inserting a picture
- Editing an existing picture
- Formatting text in an object
- Further appearance options

Changing border and color

To change the object’s background color, click the Color icon on the Appearance tab in the Editing Toolbar and select your choice from the drop-down color palette. Hovering over Transparency in this box will display ten levels of opacity to choose from. Select 100% to make the object’s background completely transparent.

To change the border color of an object, click the Border icon on the Appearance tab and select a choice from the drop-down color palette.

You can set your preferred thickness of the border by hovering over Thickness near the bottom of the drop-down color palette and selecting an option from the sub-menu.

To change the style of the border, hover over Style at the bottom of the drop-down color palette and select an option from the sub-menu.

Changing border and color

To change the object’s background color, click the Color icon on the Appearance tab in the Editing Toolbar and select your choice from the drop-down color palette. Hovering over Transparency in this box will display ten levels of opacity to choose from. Select 100% to make the object’s background completely transparent.
To change the border color of an object, click the **Border** icon on the **Appearance** tab and select a choice from the drop-down color palette.

You can set your preferred thickness of the border by hovering over **Thickness** near the bottom of the drop-down color palette and selecting an option from the sub-menu.

To change the style of the border, hover over **Style** at the bottom of the drop-down color palette and select an option from the sub-menu.

**Inserting a picture**

There are a number of different types of pictures you can include in an object. To start, click the 📷 **Picture** button on the **Appearance** tab in the **Editing Toolbar**.

- To add a picture from a **Media Library**, the current Clicker Set, your computer, or another device, click the 📦 **Browse** icon to open a **Picture Browser**. When you have browsed to your desired picture, select **Insert**.

- If you want to **paint your own picture**, select ✏️ **Paint** to launch a Paint window.

- If your computer has a webcam, you can **take a photo** with it by selecting 📶**Take Photo with webcam**.

It is possible to have the object display whichever picture is currently displayed in another cell in your Clicker Set. To do this, move your cursor over **Add picture from another cell**. From this menu, you can choose which object’s picture you would like to use.

To drag and drop pictures into an object, see **Adding pictures via "drag and drop"**.

---

**Note:** If enabled, **Instant Pictures** will appear in cells. To disable this feature, see the **Media** tab in **Clicker Set Properties**.

**Editing an existing picture**

If you click the 📷 **Picture** icon on the **Appearance** tab in the **Editing Toolbar** and select ✏️ **Paint** when the selected object already includes a picture, it will open that picture in Paint for editing.

Otherwise, inserting a new picture into an object will replace the existing one. To remove a picture from an object, click the ✕ **Remove Picture** button.
To change how a picture is positioned within an object, click the Picture Alignment button and make a selection from the drop-down menu. Auto lets Clicker decide on the best position according to the shape of the object. The other three options let you force the picture to be to the left or right of the text, or above it.

**Formatting text in an object**

You can completely customize the text displayed within an object. The tools to do this are located within the third section of the Appearance tab in the Editing Toolbar.

To set the font style and size, make a selection from the drop-down lists. You can start typing a font style to find it quickly and also type a number in the font size box before pressing Enter. There are three icons that will make text **bold**, *italicized* and *underlined* respectively when clicked.

To set the color of the object text, click the Text Color button and select a choice from the drop-down color palette.

Additionally, you can set the positioning of the text within the object by clicking the Alignment button and selecting an option from the drop-down menu.

If you are using a text box, you can change the font settings for sections of text rather than all of it at once. See Text box properties for more information.

**Further appearance options**

To change the mouse pointer shape when hovering over a cell, click the Pointer button on the Appearance tab in the Editing Toolbar and make a selection from the drop-down menu. There are several different shapes to choose from.

To have a pop-up "ToolTip" text label appear when the mouse pointer is hovering over the object, click the More Options icon and enter your text in the text box next to Tip before clicking OK.

If you don’t want the cell to appear when you print the grid, page, or pop-up, click the More Options icon and check the box next to Hide this cell when the grid is printed.

**Sending text and pictures**
By default, the text and picture in an object are sent to the Document when you click on it, but you can customize exactly what is sent by selecting an object and opening the **Send** tab on the **Editing Toolbar**.

On this tab, a box indicates what will be sent when the object is clicked. To send the **picture** shown in the object (if present), or to add a **space** or **return** after the text, check the relevant checkboxes below it.

The **Choose** button towards the right of the text box displays a drop-down menu with several choices:

- **Send the text shown in cell** – sends the text shown in the object to the Document
- **Send other text** – sends the text you specify to the Document
- **Send no text** - stops the object sending text to the Document

You can also have the object send the text content of another object in the grid, page or pop-up. To do this, click **Choose**, select **Send other text** and click **Insert**. From this menu, you can choose which object’s text you would like to link to. Subsequent changes to the text in that object will be reflected in the text sent by this object.

---

**Note**: If the cell is located on a **pop-up**, it will send its contents back to the object that opened the pop-up. See **Show a pop-up** for information on how to change this.

---

**Playing sound**

Objects can make sounds, including speech, when you click on them with the left or right mouse button. By default, you hear a cell’s text spoken when you right-click it, but there are many more options available by opening the **Sound & Video** tab on the **Editing Toolbar**.
The **Sound & Video** tab has a section relating to each mouse button. A box indicates the current item assigned to each mouse button. To hear a preview of a sound, click the **Speaker** icon. Click it again to stop the preview.

The **Choose** button towards the right of the text box displays a drop-down menu with several choices:

- **Speak the text shown in the cell** – speaks the cell’s text using Clicker’s speech engine

- **Speak other text** – speaks the text you specify using Clicker’s speech engine

  Click **Insert** to link to text in other objects in the Clicker Set

- **Play Sound or Video** – this will play a sound file from your computer, or allow you to record one

  To play an existing sound, click **Browse**, navigate to your chosen file, select it, and click **Insert**

  To **record** your own sound, select **Record**

  A list of used and recorded sound files is kept within the **Play Sound or Video** sub-menu

- **No Sound or Video** – nothing will play when that mouse button is clicked

You can also have the object play the sound content of another object in your Clicker Set. To do this, click **Choose**, and select **Add a sound or video from another cell**. From this menu, you can choose which object’s sound you would like to link to. From this point onwards, the current object will play whatever that object has been configured to play.

When speech is assigned to either mouse button, a checkbox appears that enables words to be **highlighted as they are spoken** when it is checked.
Sounds can be quickly added to a cell's left mouse button function by dragging and dropping from the Media tab or Windows Explorer.

**Tip:** A folder containing all pictures, sound and video used in the current Clicker Set is accessible from the Media tab.

**Note:** Grids/pages within tabbed sequences will display options for left-click/right-click rather than opening/closing as their tabs are clicked to open them.

---

### Playing Video

In addition to playing sounds, objects can also play video files when you click on them with the left or right mouse button. You can configure what you’d like each button to do by opening the Sound & Video tab on the Editing Toolbar.

![Editing Toolbar screenshot](image)

The Sound & Video tab has a section relating to each mouse button. A box indicates the current item assigned to each mouse button. To see a preview of a video click the **Play** icon. Click it again to stop the preview.

The Choose button towards the right of the text box displays a drop-down menu with several choices:

- **Play Sound or Video** – this will play a video clip from your computer

  To play an existing video, click **Browse**, navigate to your chosen file, select it, and click **Insert**

  A list of used files is kept within the Play Sound or Video sub-menu

- **No Sound or Video** – nothing will play when that mouse button is clicked
When either of the mouse buttons are set to play a video, a Video Details button will appear near the bottom of the appropriate section of the toolbar. Click this to choose how the video will be displayed from a list of options in a drop-down list:

- In the cell
- Scaled to half the size of the grid
- Scaled to the grid
- Filling the screen

Additionally, you can also choose whether you want the video to maintain it's original shape, or stretch to fill the available space.

You can also have the object play the video content of another object in your Clicker Set. To do this, click Choose, and select Add a sound or video from another cell. From this menu, you can choose which object’s video you would like to link to. From this point onwards, the current object will play whatever that object has been configured to play.

Videos can be quickly added to a cell's left mouse button function by dragging and dropping from the Media tab or Windows Explorer.

Tip: A folder containing all pictures, sound and video used in the current Clicker Set is accessible from the Media tab.

Note: Grids/pages within tabbed sequences will display options for left-click/right-click rather than opening/closing as their tabs are clicked to open them.

Opening items with objects

Objects can be configured to perform a variety of actions when clicked. Some actions aid in navigation between grids and pages of the Clicker Set. Other actions will open pop-ups and windows for various functions, such as the Sound Recorder.
To set an action for an object, select it and open the **Open** tab on the **Editing Toolbar**. On this tab is a box that indicates what will be opened when the object is clicked. By default, this is set to **Do Nothing**. Click the **Choose** button to select your preferred action from the drop-down menu.

These actions are:

- Move to the next, previous, or specific grid/page
- Show/close a specific pop-up
- Open **Keyboard**
- Open **Sound Recorder**
- Open **Webcam**
- Open **Paint**
- Open a **webpage**
- Open **Print Dialog**

If you choose an option that displays a pop-up or a window, you can customize its **size and location**.

You can test what will happen when your object is clicked by right-clicking it and selecting **Perform Actions**.

---

**Tip:** There are pre-programmed buttons in the **Objects** tab that can open a Keyboard, the Sound Recorder and the Webcam window.

---

**Show a pop-up**

To show a pop-up when the cell is clicked, click the **Choose** button and hover your mouse over **Show pop-up** to show a sub-menu of the pop-ups within your Clicker Set. There is the option to **create a new pop-up** at the bottom of the list.
When you have selected the pop-up you wish to appear, click More Options on the Open tab to see the extra parameters you can set.

The current location that text sent from the pop-up will go to is listed in the Send to box. To change this, click the drop-down arrow to the right and select an option from the menu. You can send text to the currently active object, to the last sending location, the Document, or you can specify an exact cell or text box.

Checking the Remove all text/Remove all pictures in this object checkboxes will remove any text or pictures already present in the current object, regardless of the pop-up's sending destination.

The next two options will allow you to limit the use of the grid or page when the pop-up is displayed. You can lock it, which disables it and keeps it visible, or fade it, which locks and darkens it.

If the pop-up is configured to send its text to a text box, the final checkbox will ensure that the cursor is kept active in that text box after the pop-up is closed when checked.

**Open the Keyboard**

Selecting this option will cause the cell to open your on-screen keyboard when clicked. For more information about this feature, see Using the on-screen keyboard.

Click More Options on the Open tab to see the extra parameters you can set.
The current location that text typed with the on-screen keyboard will go to is listed in the **Send to** box. To change this, click the drop-down arrow to the right and select an option from the menu. You can send text to the currently active object, to the last sending location, the Document, or you can specify an exact cell or text box.

Checking the **Remove all text/Remove all pictures in this object** checkboxes will remove any text or pictures already present in the current object, regardless of the pop-up’s sending destination.

The next two options will allow you to limit the use of the grid or page when the on-screen keyboard is displayed. You can **fade** it, which locks and darkens it, or **lock** it, which disables it and keeps it visible.

**Open the Sound Recorder**

Selecting this option will cause the cell to open the Sound Recorder when clicked. For more information about this feature, see **Recording sound**.

Click **More Options** on the **Open** tab to see the extra parameters you can set.

The current location that the recording will be sent is listed in the **Record Sound to** box. You can specify the exact cell you wish to play the recorded sound by clicking the drop-down arrow to the right and selecting a cell from the menu.

The next two options will allow you to limit the use of the grid or page when the Sound Recorder is displayed. You can **fade** it, which locks and darkens it, or **lock** it, which disables it and keeps it visible.

---

**Note:** You need a microphone connected to your computer in order to record sound.

---

**Tip:** A cell that displays the Sound Recorder in Click & Edit will subsequently play the recorded sound in Play Mode.

**Open the Webcam**

Selecting this option will cause the cell to display the Webcam window when clicked. For more information about this feature, see **Taking a webcam photo**.

Click **More Options** on the **Open** tab to see the extra parameters you can set.

The current location that the photo will go is listed in the **Send to** box. You can specify the exact cell you wish to display the photo taken by clicking the drop-down arrow to the right and selecting a cell from the menu.
The next two options will allow you to limit the use of the grid or page when the **Webcam** window is displayed. You can **fade** it, which locks and darkens it, or **lock** it, which disables it and keeps it visible.

**Open Paint**

Selecting this option will display cause the cell to open a **Paint** activity when clicked. See [Painting a picture](#) for further information about Paint itself.

Click [More Options](#) on the **Open** tab to access many different options and preferences which can be used to create a highly configurable Paint activity. Use the links below to find out more about a particular tab:

- **General**
- **Tools**
- **Colors**
- **Sticky Points**
- **Advanced**

For more information about Sticky Points, see [Using Sticky Points](#).

For an in-depth guide to using the Paint program, see [Using Paint](#).
To specify where the painted picture will be sent, click the drop-down arrow under **Send to** and choose a location from the menu.

You can set an image to appear above or behind your student’s work to help guide them. This is called an **assistance layer**.

Click **Choose Picture** to specify an image, which will then appear in the preview box. Check the **Save assistant layer with painting** checkbox below to keep the assistant layer as part of the finished painting. Use the radial buttons below to choose the positioning of the assistant layer.

You can have a text or audio prompt occur when the Paint window is opened. Text entered in the **Prompt** textbox will appear at the top of the window. You also have the option to **Speak the text prompt** or you can specify different text to be spoken. Alternatively, you can **Play recorded sound or video** by clicking the drop-down arrow and browsing to your chosen file.

By default, the background of a Paint canvas is transparent (which appears white), but if you’d like a different color you can click on the drop-down arrow next to **Canvas Color** and select one from the color palette.
It is possible to customize which tools will appear in your Paint window.

You can enable and disable entire groups of tools by clicking their icons in **Tools to Display**.

If selected to display, a tab will appear below for the **Brush**, **Line**, **Shape**, **Text**, and **Eraser** tools. You can use the tabs to specify the types of tool that will appear within that group.

The available tools are listed in a box on the left. The tools that will be shown in Paint appear in a box on the right. You can move items between these boxes using the **arrow** buttons.

Towards the right hand side of the window, you can choose the **Default Size** for the tool from a drop-down list (this will be the **Default Style** in the **Shape** tab). Choose the default tool for each group by clicking the icon of the current one.
Paint features a bank of words that are used as stamps to print text onto a painting. You can add/remove words from the list by opening the Text tab and clicking the + and - buttons. Use the arrow icons to change a word’s position in the list. It is also possible to specify the Font used for the words.

Click the Restore Defaults button at the bottom to revert all your changes for a particular tab.

Color options

It is possible to customize which colors will appear in your Paint window.
You can enable and disable colors palettes by clicking their icons in the **Colors Palettes to Display** to toggle them.

If selected to display, a tab will appear below for **Solid Colors**, **Colors Blends** and **Patterns**. You can use these to specify which colors will appear in these colors palettes. The available colors are listed in a box on the left. The colors that will be shown in Paint appear in a box on the right. You can move items between these boxes using the **arrow** buttons. Use the **double left arrow** button to move all items from the right box back into the left box.

Click the **Restore** button at the bottom to show the default selection of colors (12 or 24).

**Color options**

It is possible to customize which colors will appear in your Paint window.
You can enable and disable colors palettes by clicking their icons in the Colors Palettes to Display to toggle them.

If selected to display, a tab will appear below for Solid Colors, Colors Blends and Patterns. You can use these to specify which colors will appear in these colors palettes. The available colors are listed in a box on the left. The colors that will be shown in Paint appear in a box on the right. You can move items between these boxes using the arrow buttons. Use the double left arrow button to move all items from the right box back into the left box.

Click the Restore button at the bottom to show the default selection of colors (12 or 24).

Sticky Point options

Sticky Points refers to a feature of Paint which involves a grid of colored dots to be superimposed onto the canvas.

Though they can be used with the mouse, Sticky Points also provide an interface for switch users to use Paint, as they are included in scanning. If you are using switch access, Sticky Points appear automatically. They will also appear when using Sticky Point Magnetism, which will attract the
mouse cursor to a nearby Sticky Point.

To use Sticky Point Magnetism, select **Use magnetism at a distance of [x] pixels** and enter the distance around each Sticky Point that will attract the mouse pointer.

To make Sticky Points the only places on the canvas that you can move the mouse pointer, select **Restrict mouse movements to Sticky Points only**.

You can configure how the Sticky Points are scanned:

- **Sticky Points Grouping** – lets you choose whether rows or columns of Sticky Points are grouped for scanning.

- **Sticky Points Scan Order** – lets you choose whether to scan these rows and columns as groups, or simply to scan each Sticky Point individually within each row or column (Simple Scan)
Checking **After a Sticky Point is selected, resume from current position** causes the scan to continue from the current Sticky Point after selecting it. By default, the scan restarts from the beginning after a selection is made.

It is also possible to customize the appearance of the Sticky Points:

**Sticky Points Display** – select **Show all Sticky Points** to show all the Sticky Points on the canvas. Select **Show only highlighted Sticky Points** to hide all Sticky Points, only showing the current Sticky Point (or group of Sticky Points) when the mouse pointer or scan is over it.

**Sticky Points Color** – click the drop-down arrow and choose the Sticky Point color from the color palette.

**Sticky Points Highlight Color** – click the drop-down arrow and choose the Sticky Point highlight color from the color palette.

**Enlarge Highlighted Sticky Point by [x]** – enter a number to magnify the current Sticky Point by when it is highlighted.

**Advanced options**
By default, if there is a picture in the cell, grid, or page background that is set up to display a Paint picture, it appears on the canvas when Paint is launched (this is the Same as destination option).

If you prefer, the picture that appears on the canvas can be the last picture completed in Paint. This enables you to add to a picture over a series of grids or pages; for example, each page could contain an instruction to add something to the picture. To use this feature, select Last picture completed in Clicker Paint.

By default, when you update a picture in Paint and then close the Paint window, Clicker updates the picture in the cell background (this is the Update the image in the destination option).

If you set up a Master to display Paint pictures, select Create a new image in the file. This lets you create a new picture on each grid that uses the Master. If this isn’t selected, you’ll edit the same picture on each grid that uses the Master.

Using Sticky Points

Using Sticky Points

Sticky Points are a series of colored dots that are superimposed onto the canvas. They serve as a method for creating various activities that are accessible for students, including switch users.

For example, you can join any of these points together with the Line tool by selecting one then another. This is useful for such things as matching activities, where you draw lines between objects, or objects and labels.
Sticky Points can also be used to apply stamps and shapes to a painting.

Sticky Points only appear when using Sticky Point Magnetism or switch access. Sticky Point Magnetism draws your mouse pointer towards the nearest Sticky Point. To set up this up (and change other options), see Sticky Point options.

You can add and arrange Sticky Points when defining a Paint activity, which is opened from a cell. See Editing Sticky Points for further information.

Editing Sticky Points

To edit Sticky Points, right-click the cell that opens Paint when in Clicker’s Edit Mode and select Perform Actions.
The tools are inactive and the Sticky Points are shown on the canvas.

You can add, move and delete Sticky Points. You can also make a grid of regularly spaced Sticky Points.

Adding Sticky Points

To add a Sticky Point in Edit Mode, right-click the canvas where you want the Sticky Point, and select Add Sticky Point from the pop-up menu.

You can also copy Sticky Points:

1. Right-click the Sticky Point and select Copy from the pop-up menu.

2. Right-click the canvas and select Paste from the pop-up menu.

Making a Sticky Points Grid

To create a grid of regularly spaced Sticky Points:

1. Right-click the canvas and select Make Sticky Points Grid from the pop-up menu.
2. Select **Fixed number of Sticky Points** and enter the number of Sticky Points across (Horizontal) and up/down (Vertical); or select **Fixed spacing** and enter the number of pixels between each Sticky Point across the grid (Horizontal) and up/down the grid (Vertical).

**Moving Sticky Points**

To **move** a Sticky Point in **Edit Mode**, simply drag it to a new position:

1. Click the Sticky Point and hold down the mouse button.
2. Move the mouse. The Sticky Point follows your mouse pointer.
3. When the Sticky Point is in the position you want, release the mouse button.

You can also cut and paste Sticky Points:

1. Right-click the Sticky Point and select **Cut** from the pop-up menu.
2. Right-click the desired location on the canvas and select **Paste** from the pop-up menu.

To move a Sticky Point precisely, you can change its coordinates:

1. Right-click the Sticky Point to show its pop-up menu and select **Properties**.
2. Select **Relative to picture** (percentage distances on the canvas) or **Fixed coordinates** (number of pixels on the canvas) and enter numbers for **X** (across) and **Y** (up/down) to position the Sticky Point.

**Deleting Sticky Points**

To delete a Sticky Point in **Edit Mode**, right-click the Sticky Point and select **Delete** from the pop-up menu.

To delete all the Sticky Points, right-click the canvas and select **Delete All Sticky Points** from the pop-up menu. You can then add Sticky Points to the canvas.

---

**Note:** You must always have at least one Sticky Point when you close the Paint window, or Paint will create a **Sticky Points Grid**.

---

**Open a webpage**

You can configure an object to open a website, launch your email program using an email address, or launch another program when it is clicked.
To open a web page, select **Web Address** from the **Type** drop-down list and then type the web address in the **URL** text box. For example, [http://www.cricksoft.com](http://www.cricksoft.com)

To send an email, select **Email Address** from the **Type** drop-down list and type the email address in the **URL** text box. For example, [mailto:info@cricksoft.com](mailto:info@cricksoft.com)

To create any other kind of hyperlink (for example, to an **FTP** location), select **Other** from the **Type** drop-down list and type the full location (including protocol prefix) in the **URL** text box.

The selected text will become blue and underlined. Click it to visit your link.

If the object already has a hyperlink, click **Remove Hyperlink** to discard it.

**Open the Print Dialog**

You can configure an object to display a window containing several printing options when it is clicked.
Choosing one of these options will immediately start printing the relevant item(s) using your computer’s default printer. For more information about printing in Clicker 6, see Printing your work.

As the Print Dialog contains scannable cells, a student can use switches to select and choose their preferred printing option.

**Altering window size and position**

If you choose an option that involves a window appearing, such as the on-screen keyboard or Paint, you can specify the size and position of the window.

To do this, click the item's Size and Position button and select Open [item] at custom scale and position before then clicking Edit [item] size and position.

The item’s window will appear, which you can then resize and drag to your desired location in the Editing Area. If the object opening the item is on a grid, the grid will be moved to the bottom of the editing area in order to simulate it's appearance beneath a Document. Alternatively, you can enter values in the boxes in the Edit Pop-up Size and Position dialog box:

- **Size** - Enter a percentage into the Width and Height boxes, or use the arrow buttons to alter existing values. For example, entering 80% into the Width box will result in the width of the item's window being 80% of the width of the Clicker window.

- **Position** - Enter a percentage into the Left and Top boxes, or use the arrow buttons to alter existing values. For example, entering 10% into the Left box will result in the top left corner of the item's window appearing at 10% of the Clicker window's width.

Once you are done, close the dialog box to save your position.
These settings also apply to pop-ups. While you can customize how a pop-up will appear by default, that positioning can be overridden by what you specify here.

**Structuring a Clicker Set**

**Using the Outline tab**

The **Outline** tab is used to organize the contents of your Clicker Set. From here you can view and create new grids, pages, pop-ups, and Masters and arrange them in any number of sequences.

Thumbnails of grids/pages in a sequence are displayed in descending order down a vertical list. Clicking a thumbnail will select that item and show it in the **Editing Area**.

Near the top of the Outline tab is a drop-down box that allows you to view other sequences, as well as a list of pop-ups and Masters contained within the open Clicker Set.

**Sequence Properties**

You can edit the properties of a sequence by selecting it in the drop-down box and then clicking the **Properties** icon towards the right.
To rename the sequence, enter it in the **Sequence Name** box. Use the button below to delete the sequence.

You can also choose how to move between items in the sequence:

- **Use tabs** sequence along the top of the grid or page (see below)

  ![Grid with tabs](image)

- **Use the arrow tools** – arrow icons appear in the Grid Toolbar
  
  ![Arrow icons](image)

- **Only use custom links** – no navigation icons are shown: it is only possible to move between items using user-created buttons

**Ordering a sequence**

To change the order of a sequence, you can move individual grids, pages and pop-ups by clicking and dragging an item’s thumbnail. As you drag, a black bar indicates where the item will be positioned when the mouse button is released. You can even drag items into the Outline tab of another Clicker 6 window!

You can also move items using cut and paste. Right-click the thumbnail of the item you wish to move and select **Cut**, which will cause it to disappear. Right-click on another thumbnail and select **Paste**; the item that was cut will reappear below the second item. Selecting **Copy** instead of **Cut** will create a copy of the first item below the second, rather than moving it there.
Use the Cut/Copy/Paste tools to move items to other sequences within the current Clicker Set, or any other open Clicker Set. You can select many items at once by holding down the Ctrl key and clicking on multiple items before right-clicking one of them and selecting Cut or Copy.

To rename an item, right-click its thumbnail and select Rename. Select Delete to remove the item.

To add a new sequence, select Create New Sequence from the drop-down box at the top.

To delete a sequence, click the Properties icon and click Delete Sequence.

**Adding new items to a Clicker Set**

**Using Masters**

A Master is a base design that is used as a source for newly created grids, pages, or pop-ups.

When you initially create an item from a Master, it will be identical until you start to alter and add to it. However, any subsequent changes made to that Master will then be reflected in all items that have been created from it. A single change in one Master can affect many items at once.
This is useful, for example, if you wish to have several grids, pages, or pop-ups with similar layouts but different content. All Clicker Sets generated by Quick Wizards will have Masters present.

**Note:** Changes made to clusters on Masters will not update any items created from it.

You can create a new Master grid or page by clicking the Green Plus icon and selecting Add New. There is the ability to create one based on a supplied template. Choosing a Blank template allows you to create a new Master from scratch. See Creating new grids and pages for more information.

You can also quickly clone a Master by right-clicking its thumbnail and selecting Duplicate.

**Creating new grids and pages**

The easiest way to create a new grid or page is to generate one from an existing Master. To do this, navigate to a sequence and click the Green Plus icon. Hover your mouse over Add New, which will show thumbnails of the Masters within that Clicker Set. Click your choice to create a new grid or page based on that Master. Subsequent changes to the Master will be reflected in your item.

Another quick way to create a new grid, page, or pop-up is to clone an existing one by right-clicking its thumbnail and selecting Duplicate.
To create an entirely new grid or page, click the Green Plus icon and select From Template. A window will appear that displays a list of available templates.

Click one to display a window with a large preview of the current template. You can browse the folder tree shown on the right to preview other templates in other categories. Clicking once on a template's name will display its preview.

For each template, you can specify the number of grids/pages to be created. Depending on the template chosen, you are also given the opportunity to choose the number of rows and columns. Use their arrow buttons to adjust their values, or enter numbers manually in the relevant boxes.

Clicking the More Options button will give you further options to specify background color.

Creating a new pop-up

To create a new pop-up, select Pop-ups from the drop-down list at the top of the Outline tab. Click the Green Plus icon, hover over Add New and select Create New Pop-Up to launch the Add Pop-up window.
You can specify the size of your pop-up in proportion to the main Clicker window. Enter a percentage into the **Width** and **Height** boxes, or use the arrow buttons to alter existing values. For example, entering 80% into the **Width** box will result in the width of the pop-up being 80% of the width of the Clicker window.

By default, Clicker will create a pop-up with a cluster of cells on it. It is possible to specify your desired number of rows and columns of cells by entering numbers in the **Rows** and **Columns** boxes, or using the arrow buttons to adjust their values.

If you wish to design the layout of the pop-up yourself, you can uncheck the **Add Cells** checkbox to create an empty pop-up that you can add objects to after it has been created.

Clicker will place a generated Close button on your pop-up by default, however you can choose to close the pop-up when a cell is clicked instead.

Clicking the **More Options** button will give you further options to specify background color and font style. A drop-down list at the top allows you to choose how words are sorted in your pop-up.

**Pop-up size and location**

You can also specify the dimensions and location of a pop-up. To do this, select **Pop-ups** from the drop-down list at the top of the **Outline** tab and click the pop-up you wish to edit.
On the Appearance tab in the Editing Toolbar, click Pop-up Size to specify the height and width of the pop-up as a percentage relative to the size of the Clicker 6 window. You can enter numbers in the boxes, or resize the pop-up itself.

To determine where the pop-up will appear on the screen, click Default Position and select a location from the Choose menu, or specify an exact location by entering numbers in the Left and Top boxes.

**Click & Edit Mode**

**What is Click & Edit?**

Click & Edit is a new feature in Clicker 6 that offers a student the ability to edit certain features of pages within a Clicker Set and add their own content. It can be thought of as a basic, easy to use version of Edit Mode for use by students. When they have created their activity, they can then interact with it in Play Mode.

When Click & Edit is enabled for a Clicker Set, a toolbar featuring several, easy to understand tools appears at the top of every page. This gives the student the ability to save or print their work, navigate between pages, add or delete pages, as well as change the page background color.

Additionally, each object on the page can be configured to receive content from the student during Click & Edit. Cells can be populated with pictures and sounds from various sources, and textboxes can be written in with a similar level of writing support to a Document. Using the Click & Edit tab from the Editing Toolbar, you can set the tools that appear to the student when a particular object is clicked.

A typical application for this feature is a book activity. A teacher can create a book with Click & Edit enabled that has a layout and navigation buttons, but no content. The student is then presented with this Clicker Set and can proceed to populate it with their own words, pictures and sounds, before then being able to save or print it themselves.

This is another aspect in which Clicker has been designed to enable independent learning and exploration, without the need for constant supervision and assistance.

---

**Note:** Currently, it is not possible to use switch access and Mouse Dwell in conjunction with Click & Edit.
How to use Click & Edit

The **Click & Edit Toolbar** appears at the top of every page in a Clicker Set that has had Click & Edit enabled. It contains several tools that allow a student to save their work, navigate the Clicker Set and add/delete pages.

- [Previous Page] - go to the *previous page* in the Clicker Set
- [Next Page] - go to the *next page* in the Clicker Set
- [Load] - load a new Clicker Set
- [Save] - save the current Clicker Set
- [Print] - print the current Clicker Set
- [Add Page] - add another page to the Clicker Set
- [Delete Page] - delete the current *page* in the Clicker Set
- [Background Color] - change the current page's background color
- [Deactivate] - deactivates Click & Edit and plays the page

To restore Click & Edit, click the [Open Toolbar] button that appears in the bottom right corner of the status bar (or press the Esc key).

In addition to the functions above, students are also able to add content to objects on the page. If they click a cell, it becomes highlighted in yellow and a pop-up toolbar will appear that contains various ways for students to attach pictures and sounds to it. To choose which functions are available to the student, see Configuring Click & Edit.

**Text boxes** also become highlighted in yellow when clicked, and a blinking cursor indicates that text can be entered. The contents of the Click & Edit Toolbar change to provide appropriate functions for writing in the text box.
These tools correspond with the ones in the Document Toolbar and offer a student the same level of writing support when using text boxes as they are accustomed to when writing a Document. If a text box has been configured to accept content from a pop-up, this is displayed by clicking the Open word pop-up icon.

**Play Mode**

When a student has finished using Click & Edit to add content to their Clicker Set, they can then interact with it by enabling Play Mode. This is achieved by clicking the Play icon in the Click & Edit Toolbar.

This will deactivate Click & Edit and start playing the page. The Click & Edit Toolbar will disappear, text boxes will no longer be editable, and cells will no longer display a pop-up toolbar when clicked.

Instead, objects will now perform their regular actions when they are clicked upon. Cells that have had a sound or video file attached to them in Click & Edit will now play them when clicked with the left mouse button. A cell that launched a Sound Recorder in Click & Edit will now play the recorded sound.

To restore Click & Edit, click the Open Toolbar button that appears in the bottom right corner of the status bar, or press the Esc key on your keyboard.
Configuring Click & Edit

To enable Click & Edit for a Clicker Set and to define which general tools appear, see the Click & Edit tab in the Clicker Set Properties.

To determine which tools will appear when a particular object is clicked, select it while in Edit Mode and open the Click & Edit tab on the Editing Toolbar. Highlighted icons will be included in a pop-up toolbar that is displayed when that object is clicked during Click & Edit. Click an icon to toggle its selection:

-  choose a picture to display from a Picture Browser
-  take a photo with a Webcam
– launch a Paint window

– choose a sound or video to play from a Media Browser

– record themselves using the Sound Recorder

Text boxes can be configured to allow a student to enter or edit text within it during Click & Edit. This is achieved by selecting the text box, opening its Click & Edit tab, and checking the relevant checkbox.

In addition to typing with the keyboard, text boxes can also receive content that is sent from a pop-up, which you can specify from the Choose menu. This will then appear when the student clicks the Open word pop-up icon from the Click & Edit Toolbar during Click & Edit unless Open pop-up grid automatically is checked, in which case it will appear as soon as the page is opened.

Tip: Making these changes to a Master will save you having to repeat them for multiple pages.

Clicker Set Properties

You can access various settings belonging to a Clicker Set by clicking the Properties button located at the base of the Outline tab in Edit Mode. Alternatively, open the Clicker Set menu and select Clicker Set Properties.

These are settings that relate directly to a single Clicker Set and are therefore applied whenever it is open. Some of these settings will override similar options that have been configured in User Preferences.

Click the links below to view information for each tab:

• Media - settings related to Instant Pictures

• Language - specify the language of the Clicker Set

• Spelling and Toolbars - preferences relating to the Spellchecker and Grid Toolbar

• Click & Edit - enable and configure Click & Edit

• Info - a description of the Clicker Set
The settings on this tab govern how Instant Pictures and other media will appear in the Clicker Set.

Check **Use Instant Pictures in cells** to enable the automatic inclusion of a picture in cells when a keyword is typed.

A list of Media Libraries appears on this tab, which is similar to the one on the Media tab in User Preferences. This list defines the selection and order of libraries for use with Instant Pictures in the Clicker Set, rather than in the Document.

Check a library for it to be included in Instant Pictures. Use the arrow buttons towards the right of the list to control the order in which libraries are searched.

It is possible to override the user preference for Instant Pictures in the Document by checking **When this Clicker Set is in use, use Instant Pictures in the document**.

**Temporary Libraries**

A Temporary Library differs from a normal Media Library in that it is registered to the Clicker Set itself rather than to the computer that Clicker is installed on. It will therefore be used when that Clicker Set is opened on another computer.

It is generally **not necessary** to use Temporary Libraries as, by default, media used in a Clicker Set will become embedded within the Clicker Set file when it is saved (see Configuring Media Libraries).
However, this may not be ideal if you intend to use very many high resolution images or large sound/video files. If you wish to transfer the Clicker Set to another computer (that does not have the same Media Libraries registered as you), then it is advisable to use a Temporary Library to store and transport these files instead to avoid potential file corruption issues and to improve performance.

Click **Register Temporary Library** to start the wizard. All you need to supply is a name and a location for the items to be stored. When transferred to another computer, this Clicker Set will look for these items using the folder path that you provide here. It is recommended that you choose somewhere that is either centrally accessible (such as a network share on a server), or instead place the Temporary Library folder along with the Clicker Set file itself within a folder together.

Your Temporary Library will subsequently appear on the list on the Media tab of the **Clicker Set Properties**.

You can remove a Temporary Library in the same way as a normal Media Library. For further information, see **Registering a Media Library**.

**Language**

This tab will allow you to set the language of the Clicker Set. You can select from several common languages using the drop-down list. Check **View full list** to show more languages.
When you choose a language, the three checkboxes will indicate whether the current installation of Clicker has a Spellchecker dictionary, or a predictor database for that language, as well as whether it has a right-to-left writing direction.

Once set to a particular language, Clicker will attempt to load dictionary and database files for that language each time it loads the Clicker Set. For further information, see Using different languages.

**Note:** A language can be set for a Clicker Set upon creation. See Creating a new Clicker Set.

### Spelling and Toolbars

On the **Toolbars** tab, check the **Hide Grid toolbar** checkbox to prevent the Grid Toolbar from appearing in your Clicker Set.

You also have the option to **temporarily add the words used in the Clicker Set to the spellcheck dictionary** – check the box on the **Spelling** tab to enable this feature.

### Click & Edit

Use this tab to enable and configure Click & Edit for the pages in your Clicker Set.
When you check **Enable Click & Edit**, the rest of the items in the window will become selectable and no longer be grayed out.

You can determine whether you want these six tools to appear in the Click & Edit Toolbar by making a selection from their drop-down lists. If you select **User Preference**, then that tool will be enabled based on your setting in the **Look and Feel** tab in **User Preferences**.

To learn more about Click & Edit, see [What is Click and Edit?](#).

**Info**
This tab allows you to add a description to your Clicker Set to inform anyone who uses it about its content and what age range it has been designed for.

- **Title** - this is the filename that your Clicker Set has been saved with

- **Version** - increment this to indicate whether the Clicker Set has been improved or added to

- **Description** - write a short paragraph of information about your Clicker Set

- **Keywords** - include words here that relate to your Clicker Set

- **Age Range** - choose an age from each drop-down menu
Using pictures, sound and video

Using pictures in Clicker

Using pictures in Clicker

Clicker 6 comes with advanced picture support to aid and enhance teaching and learning. You can:

• Add pictures to a Document and easily position them

• Add pictures to cells in grids, pages and pop-ups

• Have cells send pictures to the Document

• Use a picture for the background of a grid, page or pop-up

• Have pictures appear while typing in a Document

In addition to using existing pictures in activities, Clicker 6 introduces several ways for users to create new images, such as being able to take a webcam photo or paint one themselves!

Note: Clicker 6 accepts picture files with these extensions: .jpg  .jpeg  .png  .tif  .tiff  .bmp  .gif

Adding pictures
• To add a picture to a Document, see Using pictures in a Document

• To add a picture to an object, you can use the Media tab, Instant Pictures, or the Editing Toolbar

• To set a picture as a background for a grid, page, or pop-up, see the Changing the background

• You can also drag and drop pictures from Windows Explorer or from a webpage.

Instant Pictures

When using Instant Pictures support, pictures from your Media Libraries appear above typed words or phrases that match their filename (not including extension) or one of their keywords. For example, the pictures in this grid have automatically been added after the words were typed.
Instant Pictures can appear in a variety of places, including a Document, the Predictor, the Spellchecker, or cells and text boxes within a Clicker Set.

You can choose which libraries the pictures come from, including Clicker’s own Crick Picture Library 3, symbol libraries, and your own libraries.

To configure Instant Pictures in cells, see the Media tab in the Clicker Set Properties. To choose which other features have Instant Pictures enabled, and to select which Media Libraries are searched for pictures, see the Media tab in User Preferences.

By default, a picture in a Media Library will appear when its filename is typed. If you wish for a picture to appear when other words are typed, you can add additional keywords.

**Taking a webcam photo**

A new feature in Clicker 6 is the ability for users to take a photo using their webcam and then easily use that photo within their activities.
You can take a webcam picture when adding pictures to a Document, changing the background of a grid, page, or pop-up, and inserting a picture into a cell.

A window will appear with a live preview from your webcam. When you are ready, click the **Click here to take a photo** button at the top. There will be a three second countdown before the photo is taken.

After a photo has been taken, you can click **✓ Use this photo** to include your photo as a picture in Clicker. If you wish to retake the photo, click the **✓ Start Again** button. Clicking **✗ Cancel** will close the window without saving.

---

**Note:** You need a webcam connected to your computer in order to take a photo.

---

**Painting a picture**

Our fantastic **Paint** software is now integrated with Clicker 6. This allows users to demonstrate their creativity and produce their own pictures through the use of stamps, paint, and shape tools.
You can launch Paint when adding pictures to a Document, changing the background of a grid, page, or pop-up, and inserting a picture into a cell.

Additionally, you can create a button that displays a highly configurable Paint activity that can send the finished image to the destination of your choice. To find out more, see Open Paint.

The Paint window is easy to navigate, even for switch users. Once you have finished your picture, select the ✓ icon to close the window and your drawing will appear in Clicker 6.

See Using Paint for information on how to use Paint itself.

Tip: You can save your Paint picture as a .jpg, .png, .bmp or .gif image file at any time by opening the Clicker Set menu and selecting Save Picture As.

Adding pictures via "drag and drop"

In addition to the many ways of including pictures in your Clicker Sets from within the program, you can also "drag and drop" file directly into Clicker from elsewhere on your computer.
To do this, hold your mouse button down on the file or Internet picture you wish to use, drag the file into a Clicker 6 window and release the button while hovering over your chosen location:
• Releasing over the Document will insert the picture into that Document at the cursor position

• Releasing over an empty area of a grid, page or pop-up in Edit Mode will create a cell with the picture in it

• Releasing over a cell in Edit Mode will cause it to display that picture

If Clicker 6 is open but the window is either minimized or hidden, drag the file down to your Taskbar and hover over Clicker 6 until its window appears, at which point you can move your mouse cursor into the window.

**Note:** When dragging pictures from a webpage, ensure that the picture is not a hyperlink and that Internet Explorer’s Protected Mode is disabled.

**Note:** Clicker 6 accepts picture files with these extensions: .jpg .png .tif .tiff .bmp .gif

**Using sound and video in Clicker**

**Using sound and video in Clicker**

Clicker 6 includes some of the latest speech engines designed by Acapela, regarded as one of the world’s finest speech engine companies. They can read text aloud to help aid comprehension and understanding in reading and writing activities.

By default, Clicker speaks sentences written in a Document automatically and highlights the words as it speaks. It can be configured to speak letters or words as they are written, or speak words when you click them. For more information about using speech while writing a Document, see Using Speech.

In addition to its speech support, Clicker also allows you to use sounds in your Clicker Sets. For the left and right mouse buttons, you can specify whether you would like a cell to play a sound or read some text when it is clicked.

Along with sound, you can also include video clips within your Clicker Sets. A video can be played by performing actions such as clicking a cell or moving between grids/pages. There are several different ways videos can be displayed in Clicker. In addition to showing them in full screen mode, Clicker can also play videos inside a grid or even within a cell!

**Note:** Video support was added in version 6.15. To check your version, open the Help menu and click About Clicker 6.
Note: Clicker 6 accepts .mp3 and .wav sound files along with .avi, .mpg, .mpeg, .wmv, .ovg and .mov video files. Third party codecs may be required depending on your version of Windows.

Adding sound and video

As well as sending text and opening items when clicked upon, objects can also be configured to play sound and video.

You can specify a media file to be played, record some audio, or supply text to be read aloud by the speech engine. It's even possible to create a link between two objects and have one play whatever has been configured in the other!

This can be done from an object's Sound & Video tab. Different configurations can be defined for both left and right mouse button clicks. See Playing sound and Playing video for further details.

Additionally, sound and video content can also be played when opening and/or closing a grid, page, or pop-up. To discover how to play sound and video when moving between grids, see Transition sound effects and Transition video effects.

It is also possible to add a sound or video directly to a cell by dragging and dropping from Windows Explorer.

Recording Sound

As well as playing existing sound files, it is also possible to record your own sound clips for use in Clicker activities.
To record sound into a cell, you can either:

• Record sound directly into a cell which plays when you click it. To do this, see Playing Sound and select Record

• Create a pop-up sound recorder **button** that records sound into another cell. To do this, see Open Sound Recorder

When the Sound Recorder window appears, click the **Record** button to start recording sound. A large red ‘Recording’ band will appear to indicate this. When you are finished, click the **Stop** button.

Click the **Play** button to listen to your recording. Click the **OK** button to save your recording, or click the **Cancel** button to close the pop-up without saving.

**Note:** You need a microphone connected to your computer in order to record sound.

**Tip:** A cell that displays the Sound Recorder in Click & Edit will subsequently play the recorded sound in Play Mode.

**Adding sound and video via "drag and drop"**

In addition to multiple methods of including sound and videos in your Clicker Sets from within the program, you can also "drag and drop" files directly into Clicker from elsewhere on your computer.
To do this, browse to the location that contains your media files in Windows Explorer, such as your Desktop or Documents folder. Hold your mouse button down on your chosen sound or video file, drag it into a Clicker 6 window and release the button while hovering over a cell. Doing so will add that sound or video the cell's left mouse button action. For more information, see Playing sound and Playing video.

If Clicker 6 is open but the window is either minimized or hidden, drag the file down to your Taskbar and hover over Clicker 6 until its window appears, at which point you can move your mouse cursor into the window.

**Note:** Clicker 6 accepts .mp3 and .wav sound files along with .avi, .mpg, .mpeg, .wmv, .ovg and .mov video files. Third party codecs may be required depending on your version of Windows.

**Managing Media Libraries**

Media Libraries are a quick and simple way of cataloging media on your computer for easy access in Clicker 6. You create a Media Library by selecting a folder on your computer or network and specifying a name for it. This will then be located in the Media Libraries folder that appears in every Media Browser, as well as the Media tab in the Sidebar during Edit Mode.
The benefit of this is to make it simpler and less time-consuming to browse your media in Clicker 6, compared to navigating through your computer’s folder structure each time you wish to include a picture or sound within your Clicker Set.

It also unlocks the advanced picture features of Clicker 6, such as the ability to have pictures appear instantly when typing words in the Document or in cells within a Clicker Set. To find out more, see Instant Pictures.

Clicker 6 comes with the Crick Picture Library 3: an automatically registered Media Library that contains over 2,500 high quality pictures to illustrate common words and phrases.

**Note:** You need to have administrator access to register and configure a Media Library.

**Registering a Media Library**
To create a new Media Library, click **Options** followed by **Media Libraries**.

1. Click **Register New** Library to start the wizard

2. Type a name for your library and click **Next**

3. Click **Browse** to navigate to the folder that stores your media files. Click **Open** and then **Next**

4. Specify a library identifier (a default is generated for you). Click **Next**

5. Choose whether you want to **Embed media within the Clicker Set** and/or **Always use the library with Instant Pictures**. Click **Create**

To **remove** a registered Media Library, select its name from the list and click **Remove**.

**Note:** You need be logged on as an administrator to register and configure a Media Library.
Configuring Media Libraries

To view the properties of a registered Media Library, select its name from the list and click Properties.

**Library Name** – type a new name into the box to change it

**Folder** – shows the location of the library. Click **Change Folder** to browse to a new location

**Languages** – see Languages in Media Libraries

**Embed media from this library in Clicker Sets** – with this checked, any media used in a Clicker Set is saved directly into the single Clicker Set file. If unchecked, the correct media libraries need to be registered in order for media in the Clicker Set to display on a particular machine
Always use this library for Instant Pictures – with this checked, the library will always be used for Instant Pictures. For more information, see the Media tab in User Preferences.

Languages in Media Libraries

It is possible for a Media Library to be available in several languages. For example, the supplied Crick Picture Library 3 is localized into UK, US, and Australian English. You can easily create translations of your own libraries. For libraries featuring pictures in particular, this is a useful way of introducing students to other languages.

Differences between languages are not just limited to words. Both the order and the visibility of items are remembered per language. For example, in the Crick Picture Library 3, there are several different police officer pictures. As uniforms differ between countries, the other pictures are hidden so that each language will only display the police officer picture applicable to them.

To view a Media Library’s languages, click Options, Media Libraries, select its name from the list, and click Properties. The languages currently available for this library are presented in a list. You can delete a language, or set one to be the default by using the buttons to the right of the list.

Creating a new translation

To translate a Media Library into a new language, open its Properties and click Add Language. Select the language you wish from the drop-down menu (you may need to check View Full List).

You have the option of creating the translation based on the original filenames, or based on an existing language included in that Media Library.

You can then use the Media tab to rename your items into the new language.

The Media tab
Using the Media tab

To include a picture or sound in your Clicker Set during Edit Mode, open the Media tab on the Sidebar and browse to your desired media. Click and drag the item onto your current grid, page, or pop-up, and release the mouse button.

If you drag a media file onto an existing cell, it will become attached to it.

For example, dragging a picture onto a cell will cause it to display that picture. Dragging a sound file onto a cell will set it to be played when that cell is left-clicked with the mouse.

If you drag a picture elsewhere on the grid, page, or pop-up background, a transparent cell will be created that features the picture.

To view hidden items within Media Libraries, click the View icon and check Show Hidden items. Hidden items will appear semi-transparent.

Navigating the Media tab

You can access your pictures, sounds and videos when in Edit Mode by opening the Media tab on the Sidebar. You can choose to browse your Desktop, Documents, your Media Libraries, as well as
items currently within the current Clicker Set. You can return to this point by clicking the Home icon near the top of the tab.

As you navigate through your folders, you can go backwards and forwards to locations you’ve visited by using the Arrow icons. To view the parent folder that contains your current folder, click the Parent Folder icon.

If you are browsing a Media Library with multiple languages available, such as the Crick Picture Library 3, you can switch between them by clicking the Languages icon and making a selection from the drop-down menu. To learn more about languages in Media Libraries, see Languages in Media Libraries.

To change how items in the Media tab are displayed, you can shift to a different view by clicking the View icon and making a selection from the drop-down menu. You can choose between icon (gallery) and detailed (columns of file information) views, with the option of large or small icons for each.

You can search for files by using the search box. Type the name of the file you are looking for into the search box and click the Search icon (or press Enter). Clicker will search the current folder and subfolders for any matches to your search term. To clear the search results and return to the previous view, click the Back icon.

Note: You can choose which locations are accessible to browse on the Media tab of User Preferences.
Setting additional keywords

If a Media Library has been selected for use with Instant Pictures, you can specify additional keywords that will trigger a picture to appear.

To do this, open the Media tab, browse to your chosen Media Library, switch to either of the detailed view modes and double-click in the Keywords column. This will allow you to type extra words.

Multiple words need to be separated with a semicolon and space, otherwise they will be collectively treated as a phrase.

Using Media Browsers

The Media tab in the Sidebar displays both picture and sound files. In circumstances when you are adding a specific type of media, you are presented with a browser that only displays files of that type.
For example, when inserting a picture in a cell, you are shown a Picture Browser and when inserting sound in a cell, you are presented with a Sound Browser.

These Media Browsers have the same controls as the Media tab and can be used in the same way. The single difference is that instead of dragging files to a location, one or more items are selected and then chosen with an Insert button.
Using pictures, sound, and video

Using pictures in Clicker

Clicker 6 comes with advanced picture support to aid and enhance teaching and learning. You can:

- Add pictures to a Document and easily position them
- Add pictures to cells in grids, pages and pop-ups
- Have cells send pictures to the Document
- Use a picture for the background of a grid, page or pop-up
- Have pictures appear while typing in a Document

In addition to using existing pictures in activities, Clicker 6 introduces several ways for users to create new images, such as being able to take a webcam photo or paint one themselves!

Note: Clicker 6 accepts picture files with these extensions: .jpg .jpeg .png .tif .tiff .bmp .gif

Adding pictures
• To add a picture to a Document, see Using pictures in a Document

• To add a picture to an object, you can use the Media tab, Instant Pictures, or the Editing Toolbar

• To set a picture as a background for a grid, page, or pop-up, see the Changing the background

• You can also drag and drop pictures from Windows Explorer or from a webpage.

**Instant Pictures**

When using Instant Pictures support, pictures from your Media Libraries appear above typed words or phrases that match their filename (not including extension) or one of their keywords. For example, the pictures in this grid have automatically been added after the words were typed.
Using pictures, sound, and video

Instant Pictures can appear in a variety of places, including a Document, the Predictor, the Spellchecker, or cells and text boxes within a Clicker Set.

You can choose which libraries the pictures come from, including Clicker’s own Crick Picture Library 3, symbol libraries, and your own libraries.

To configure Instant Pictures in cells, see the Media tab in the Clicker Set Properties. To choose which other features have Instant Pictures enabled, and to select which Media Libraries are searched for pictures, see the Media tab in User Preferences.

By default, a picture in a Media Library will appear when its filename is typed. If you wish for a picture to appear when other words are typed, you can add additional keywords.

Taking a webcam photo

A new feature in Clicker 6 is the ability for users to take a photo using their webcam and then easily use that photo within their activities.
You can take a webcam picture when adding pictures to a Document, changing the background of a grid, page, or pop-up, and inserting a picture into a cell.

A window will appear with a live preview from your webcam. When you are ready, click the "Click here to take a photo" button at the top. There will be a three second countdown before the photo is taken.

After a photo has been taken, you can click "Use this photo" to include your photo as a picture in Clicker. If you wish to retake the photo, click the "Start Again" button. Clicking "Cancel" will close the window without saving.

**Note:** You need a webcam connected to your computer in order to take a photo.

**Painting a picture**

Our fantastic Paint software is now integrated with Clicker 6. This allows users to demonstrate their creativity and produce their own pictures through the use of stamps, paint, and shape tools.
You can launch Paint when adding pictures to a Document, changing the background of a grid, page, or pop-up, and inserting a picture into a cell.

Additionally, you can create a button that displays a highly configurable Paint activity that can send the finished image to the destination of your choice. To find out more, see Open Paint.

The Paint window is easy to navigate, even for switch users. Once you have finished your picture, select the ✓ icon to close the window and your drawing will appear in Clicker 6.

See Using Paint for information on how to use Paint itself.

Tip: You can save your Paint picture as a .jpg, .png, .bmp or .gif image file at any time by opening the Clicker Set menu and selecting Save Picture As.

Adding pictures via "drag and drop"

In addition to the many ways of including pictures in your Clicker Sets from within the program, you can also "drag and drop" file directly into Clicker from elsewhere on your computer.
To do this, hold your mouse button down on the file or Internet picture you wish to use, drag the file into a Clicker 6 window and release the button while hovering over your chosen location:
Using pictures, sound, and video

- Releasing over the Document will insert the picture into that Document at the cursor position.
- Releasing over an empty area of a grid, page or pop-up in Edit Mode will create a cell with the picture in it.
- Releasing over a cell in Edit Mode will cause it to display that picture.

If Clicker 6 is open but the window is either minimized or hidden, drag the file down to your Taskbar and hover over Clicker 6 until its window appears, at which point you can move your mouse cursor into the window.

**Note:** When dragging pictures from a webpage, ensure that the picture is not a hyperlink and that Internet Explorer’s Protected Mode is disabled.

**Note:** Clicker 6 accepts picture files with these extensions: .jpg .png .tif .tiff .bmp .gif

**Using sound and video in Clicker**

Clicker 6 includes some of the latest speech engines designed by Acapela, regarded as one of the world’s finest speech engine companies. They can read text aloud to help aid comprehension and understanding in reading and writing activities.

By default, Clicker speaks sentences written in a Document automatically and highlights the words as it speaks. It can be configured to speak letters or words as they are written, or speak words when you click them. For more information about using speech while writing a Document, see Using Speech.

In addition to its speech support, Clicker also allows you to use sounds in your Clicker Sets. For the left and right mouse buttons, you can specify whether you would like a cell to play a sound or read some text when it is clicked.

Along with sound, you can also include video clips within your Clicker Sets. A video can be played by performing actions such as clicking a cell or moving between grids/pages. There are several different ways videos can be displayed in Clicker. In addition to showing them in full screen mode, Clicker can also play videos inside a grid or even within a cell!

**Note:** Video support was added in version 6.15. To check your version, open the Help menu and click About Clicker 6.
Note: Clicker 6 accepts .mp3 and .wav sound files along with .avi, .mpg, .mpeg, .wmv, .ovg and .mov video files. Third party codecs may be required depending on your version of Windows.

Adding sound and video

As well as sending text and opening items when clicked upon, objects can also be configured to play sound and video.

You can specify a media file to be played, record some audio, or supply text to be read aloud by the speech engine. It's even possible to create a link between two objects and have one play whatever has been configured in the other!

This can be done from an object's Sound & Video tab. Different configurations can be defined for both left and right mouse button clicks. See Playing sound and Playing video for further details.

Additionally, sound and video content can also be played when opening and/or closing a grid, page, or pop-up. To discover how to play sound and video when moving between grids, see Transition sound effects and Transition video effects.

It is also possible to add a sound or video directly to a cell by dragging and dropping from Windows Explorer.

Recording Sound

As well as playing existing sound files, it is also possible to record your own sound clips for use in Clicker activities.
To record sound into a cell, you can either:

- Record sound directly into a cell which plays when you click it.
  
  To do this, see Playing Sound and select Record

- Create a pop-up sound recorder button that records sound into another cell.
  
  To do this, see Open Sound Recorder

When the Sound Recorder window appears, click the Record button to start recording sound. A large red ‘Recording’ band will appear to indicate this. When you are finished, click the Stop button.

Click the Play button to listen to your recording. Click the OK button to save your recording, or click the Cancel button to close the pop-up without saving.

Note: You need a microphone connected to your computer in order to record sound.

Tip: A cell that displays the Sound Recorder in Click & Edit will subsequently play the recorded sound in Play Mode.

Adding sound and video via "drag and drop"

In addition to multiple methods of including sound and videos in your Clicker Sets from within the program, you can also "drag and drop" files directly into Clicker from elsewhere on your computer.
To do this, browse to the location that contains your media files in Windows Explorer, such as your Desktop or Documents folder. Hold your mouse button down on your chosen sound or video file, drag it into a Clicker 6 window and release the button while hovering over a cell. Doing so will add that sound or video the cell's left mouse button action. For more information, see Playing sound and Playing video.

If Clicker 6 is open but the window is either minimized or hidden, drag the file down to your Taskbar and hover over Clicker 6 until its window appears, at which point you can move your mouse cursor into the window.

Note: Clicker 6 accepts .mp3 and .wav sound files along with .avi, .mpg, .mpeg, .wmv, .ovg and .mov video files. Third party codecs may be required depending on your version of Windows.

Managing Media Libraries

Media Libraries are a quick and simple way of cataloging media on your computer for easy access in Clicker 6. You create a Media Library by selecting a folder on your computer or network and specifying a name for it. This will then be located in the Media Libraries folder that appears in every Media Browser, as well as the Media tab in the Sidebar during Edit Mode.
The benefit of this is to make it simpler and less time-consuming to browse your media in Clicker 6, compared to navigating through your computer’s folder structure each time you wish to include a picture or sound within your Clicker Set.

It also unlocks the advanced picture features of Clicker 6, such as the ability to have pictures appear instantly when typing words in the Document or in cells within a Clicker Set. To find out more, see [Instant Pictures](#).

Clicker 6 comes with the **Crick Picture Library 3**: an automatically registered Media Library that contains over 2,500 high quality pictures to illustrate common words and phrases.

**Note:** You need to have administrator access to register and configure a Media Library.

**Registering a Media Library**
To create a new Media Library, click **Options** followed by **Media Libraries**.

1. Click **Register New Library** to start the wizard
2. Type a name for your library and click **Next**
3. Click **Browse** to navigate to the folder that stores your media files. Click **Open** and then **Next**
4. Specify a library identifier (a default is generated for you). Click **Next**
5. Choose whether you want to **Embed media within the Clicker Set** and/or **Always use the library with Instant Pictures**. Click **Create**

To **remove** a registered Media Library, select its name from the list and click **Remove**.

**Note:** You need be logged on as an administrator to register and configure a Media Library.
Configuring Media Libraries

To view the properties of a registered Media Library, select its name from the list and click Properties.

- **Library Name** – type a new name into the box to change it
- **Folder** – shows the location of the library. Click Change Folder to browse to a new location
- **Languages** – see Languages in Media Libraries
- **Embed media from this library in Clicker Sets** – with this checked, any media used in a Clicker Set is saved directly into the single Clicker Set file. If unchecked, the correct media libraries need to be registered in order for media in the Clicker Set to display on a particular machine
Always use this library for Instant Pictures – with this checked, the library will always be used for Instant Pictures. For more information, see the Media tab in User Preferences.

Languages in Media Libraries

It is possible for a Media Library to be available in several languages. For example, the supplied Crick Picture Library 3 is localized into UK, US, and Australian English. You can easily create translations of your own libraries. For libraries featuring pictures in particular, this is a useful way of introducing students to other languages.

Differences between languages are not just limited to words. Both the order and the visibility of items are remembered per language. For example, in the Crick Picture Library 3, there are several different police officer pictures. As uniforms differ between countries, the other pictures are hidden so that each language will only display the police officer picture applicable to them.

To view a Media Library’s languages, click Options, Media Libraries, select its name from the list, and click Properties. The languages currently available for this library are presented in a list. You can delete a language, or set one to be the default by using the buttons to the right of the list.

Creating a new translation

To translate a Media Library into a new language, open its Properties and click Add Language. Select the language you wish from the drop-down menu (you may need to check View Full List).

You have the option of creating the translation based on the original filenames, or based on an existing language included in that Media Library.

You can then use the Media tab to rename your items into the new language.

The Media tab
Using the Media tab

To include a picture or sound in your Clicker Set during Edit Mode, open the Media tab on the Sidebar and browse to your desired media. Click and drag the item onto your current grid, page, or pop-up, and release the mouse button.

If you drag a media file onto an existing cell, it will become attached to it.

For example, dragging a picture onto a cell will cause it to display that picture. Dragging a sound file onto a cell will set it to be played when that cell is left-clicked with the mouse.

If you drag a picture elsewhere on the grid, page, or pop-up background, a transparent cell will be created that features the picture.

To view hidden items within Media Libraries, click the View icon and check Show Hidden items. Hidden items will appear semi-transparent.

Navigating the Media tab

You can access your pictures, sounds and videos when in Edit Mode by opening the Media tab on the Sidebar. You can choose to browse your Desktop, Documents, your Media Libraries, as well as...
items currently within the current Clicker Set. You can return to this point by clicking the Home icon near the top of the tab.

As you navigate through your folders, you can go backwards and forwards to locations you’ve visited by using the Arrow icons. To view the parent folder that contains your current folder, click the Parent Folder icon.

If you are browsing a Media Library with multiple languages available, such as the Crick Picture Library 3, you can switch between them by clicking the Languages icon and making a selection from the drop-down menu. To learn more about languages in Media Libraries, see Languages in Media Libraries.

To change how items in the Media tab are displayed, you can shift to a different view by clicking the View icon and making a selection from the drop-down menu. You can choose between icon (gallery) and detailed (columns of file information) views, with the option of large or small icons for each.

You can search for files by using the search box. Type the name of the file you are looking for into the search box and click the Search icon (or press Enter). Clicker will search the current folder and subfolders for any matches to your search term. To clear the search results and return to the previous view, click the Back icon.

Note: You can choose which locations are accessible to browse on the Media tab of User Preferences.
Setting additional keywords

If a Media Library has been selected for use with Instant Pictures, you can specify additional keywords that will trigger a picture to appear.

To do this, open the Media tab, browse to your chosen Media Library, switch to either of the detailed view modes and double-click in the Keywords column. This will allow you to type extra words.

Multiple words need to be separated with a semicolon and space, otherwise they will be collectively treated as a phrase.

Using Media Browsers

The Media tab in the Sidebar displays both picture and sound files. In circumstances when you are adding a specific type of media, you are presented with a browser that only displays files of that type.
For example, when inserting a picture in a cell, you are shown a Picture Browser and when inserting sound in a cell, you are presented with a Sound Browser.

These Media Browsers have the same controls as the Media tab and can be used in the same way. The single difference is that instead of dragging files to a location, one or more items are selected and then chosen with an Insert button.
Paint adds a comprehensive set of painting features to Clicker 6, offering a whole new range of learning opportunities. It can boost independence for emerging writers, as they can paint a picture to show the main idea. This helps them to think about what they want to write.

It also promotes active comprehension for all abilities, as students can demonstrate understanding by illustrating their writing. Additionally, Paint can help to engage and motivate developing writers through the ability to populate talking books with their own paintings and voice.

Paint, like Clicker, is also accessible to all and provides more access for switch users than conventional paint applications.

Read this section for information on how to use Paint itself. For information on creating Paint activities, see Painting a picture.

Tip: You can save your Paint picture as a .jpg, .png, .bmp or .gif image file at any time by opening the Clicker Set menu and selecting Save Picture As.
Getting started

Paint tools

When you create a new picture or open a saved picture, the canvas in the center of the screen is surrounded by a variety of tools:

- **Brush** – paint freehand
- **Fill** – change an area of color
- **Line** – draw straight lines and arrows
- **Shape** – add a regular, preset shape
- **Text** – add letters, numbers or words
- **Stamp** – stamp pictures on the canvas
- **Eraser** – remove what’s on the canvas
- **Selection** – cut, copy or paste rectangular areas

Note: These tools can be made available or unavailable.

Rotate/Flip tools

The **Rotate/Flip** tools let you transform the entire canvas, a selected area, or a stamp.

- **Rotate Left** – reorient counter-clockwise
- **Rotate Right** – reorient clockwise
- **Flip Left to Right** – reverse the picture to make a mirror image
- **Flip Top to Bottom** – reverse the picture to put the top at the bottom and vice versa
Note: This group of tools can be made available or unavailable.

**Undo/Redo tools**

The *Undo/Redo* tools let you go backwards and forwards through your actions, so you can correct mistakes.

- **Undo** – remove your actions
- **Redo** – redo actions you’ve undone

Note: This group of tools can be made available or unavailable.

**Color Palettes**

There are four main ways to use color:

- **Solid Color** – standard, uniform colors
- **Color Blends** – colors that blend into each other
- **Patterns** – preset styles
- **Color Mixer** – create your own colors

Note: These palettes can be made available or unavailable.

**Color Palettes**

There are four main ways to use color:

- **Solid Color** – standard, uniform colors
- **Color Blends** – colors that blend into each other
Using the tools

When you select the Brush, Fill, Line, Shape, Text, Stamp, Eraser and Selection tools, different options become available.

To choose which tools, options and colors are available, see Tool options and Color options.

The Brush tool

Choose the Brush tool to paint freehand on the canvas.

Click the canvas and hold down the mouse button. Drag the mouse to move the brush over the canvas, and then release the mouse button.

You can change the size, style and color of the brush.

The Selection tool

Choose the Selection tool to cut, copy or paste rectangular areas.

To select an area, click the canvas and hold the mouse...
Using Paint

button down. Move the mouse to select an area of the canvas, and then release the mouse button.

To cut the selected area from the canvas, select \cut, or to copy it, select \copy. The selection then appears in the Clipboard area.

To add what’s in the Clipboard area to the canvas, select \paste. Then click where you want the selection to appear on the canvas.

When you select \paste, it changes to Cancel. Select Cancel if you don’t want to paste what’s in the Clipboard area.

To change the size of what you’re about to paste, select a size from the Sizes area.

You can also use the \rotate and \flip tools to rotate or flip the selected area.

The Fill tool

Choose the \fill tool to change an area of color.

Click the canvas. The area filled is the area around the mouse pointer with the same color as the place you clicked.

The area is filled with the color, blend or pattern you have selected.
The Line tool

Choose the Line tool to draw a straight line or arrow.

Click the canvas and hold down the mouse button. Move the mouse to draw the line, and then release the mouse button.

Alternatively, click where you want the line to start, and then click where you want the line to end.

You can change the color and width of the line, and add arrowheads and line endings.

To change the width of the line, select a width from the central column.

To draw an arrow, select a Triangle or Swept arrowhead or Circle line end from the left-hand and right-hand columns. The left-hand column is the line style where you start drawing the line. The right-hand column is the line style where you finish drawing the line.

To draw a simple straight line, select straight lines in the left-hand and right-hand columns.

The Shape tool

Choose the Shape tool to add a regular, preset shape.

You can change the shape, shape style (solid or outline) and color.

Click the canvas and hold down the mouse button. Drag the mouse to change the size and orientation of the shape on the canvas, and then release the mouse button.

Alternatively, click the canvas to start the shape; move the mouse; and then click again to finish the shape.
The Text tool

Choose the Text tool to add letters, numbers or words.

You can right-click on a letter, number or word to hear it.

To change the letter, number or word, select a character set and then select the character or text you want to add.

Click the canvas to add the selected letter, number or word.

You can change the size and color of the text.

If adding words, you can use the Back and Forward buttons to page through the words.

Note: The default words describe the default pictures for the Stamp tool. To add your own words, see Text tool options.
Choose the **Stamp** tool to stamp pictures on the canvas.

Select a stamp, a size for the stamp, and click the canvas to add it to the picture.

To see more stamps, use the **Back** and **Forward** buttons to page through the stamps.

You can use the **Rotate** and **Flip** tools to rotate or flip the selected stamp.

It is possible to include your own pictures as stamps when creating a Paint activity. Do this from the **Tools** option window.

**Note:** The default stamps are pictures to match the default words for the **Text tool**.

**The Eraser tool**

Choose the **Eraser** tool to remove what’s on the canvas.

You can change the eraser size and shape. You can also clear everything that’s on the canvas.

**Note:** The Eraser and the **Clear All** option only remove what’s been added to the canvas, not the **assistant layer**.
The Selection tool

Choose the Selection tool to cut, copy or paste rectangular areas.

To select an area, click the canvas and hold the mouse button down. Move the mouse to select an area of the canvas, and then release the mouse button.

To cut the selected area from the canvas, select Cut, or to copy it, select Copy. The selection then appears in the Clipboard area.

To add what’s in the Clipboard area to the canvas, select Paste. Then click where you want the selection to appear on the canvas.

When you select Paste, it changes to Cancel. Select Cancel if you don’t want to paste what’s in the Clipboard area.

To change the size of what you’re about to paste, select a size from the Sizes area.
You can also use the Rotate and Flip tools to rotate or flip the selected area.

Colors, blends and patterns

When you use the Brush, Fill, Line, Shape or Text tool, you can select the tool color. You can use solid color, blends, patterns or the color mixer.

Select a color, blend or pattern and then use your choice of tool to add it to the canvas.

Note: To choose which colors are available or to change the canvas color, see Color options.

Tip: You can create your own pattern using the Shape tool.
Instead of using a preset color you can mix your own colors with the color mixer.

To build a set of mixed colors, first select the box that will contain the mixed color.

To create a mixed color, select a color on the palette to add a shade of it to the box. Continue until you have mixed the color you want.

If you can see a color on the canvas that you want, select the Color Picker, and then click on the color on the canvas. The color is then added to the box.

To clear the contents of the currently selected box, select Clear.

When you have created your color, you can use the Brush, Fill, Line, Shape or Text tools to add it to the canvas.
Color mixer

Instead of using a preset color you can mix your own colors with the color mixer.

To build a set of mixed colors, first select the box that will contain the mixed color.

To create a mixed color, select a color on the palette to add a shade of it to the box. Continue until you have mixed the color you want.

If you can see a color on the canvas that you want, select the Color Picker, and then click on the color on the canvas. The color is then added to the box.

To clear the contents of the currently selected box, select Clear.

When you have created your color, you can use the Brush, Fill, Line, Shape or Text tools to add it to the canvas.

Using Sticky Points

Sticky Points are a series of colored dots that are superimposed onto the canvas. They serve as a method for creating various activities that are accessible for students, including switch users.

For example, you can join any of these points together with the Line tool by selecting one then another. This is useful for such things as matching activities, where you draw lines between objects, or objects and labels.
Sticky Points can also be used to apply stamps and shapes to a painting.

Sticky Points only appear when using Sticky Point Magnetism or switch access. Sticky Point Magnetism draws your mouse pointer towards the nearest Sticky Point. To set up this up (and change other options), see Sticky Point options.

You can add and arrange Sticky Points when defining a Paint activity, which is opened from a cell. See Editing Sticky Points for further information.

**How to use switches with Paint**

When using switches as an access method in Paint, a coloured "scan" highlights the tools in turn. When the scan highlights the desired set of tools or colors, you can then press a switch to start scanning within that group. Use a switch again to select and activate a particular item when highlighted.

All the tools and colors can be scanned and selected with switches. Sticky Points can be scanned too, enabling switch users to apply the selected tool to areas of the canvas.
If you are using one switch, the scan moves to the next cell automatically after a delay (which you can change). If using two switches, you can move the scan to the next cell with one switch and select a cell with the other. If you have this option selected, you can use the F7 and F8 keys on your keyboard to simulate switch presses.

For more information, see Using User Access.

**Example activities**

**Example activities**

It's easy to create your own activities in Paint.

Here are a few examples:

- Creating a coloring-in activity
- Creating a magic painting activity
- Adding stamps to a background picture
- Creating a matching activity

**Creating a coloring-in activity**
To create a coloring-in activity, use the tools to draw a black and white outline picture; or if you already have a picture to color in, add it as a background assistant layer.

Then simply use the Fill tool and colors to fill in the white gaps. You can hide all the tools except the Fill tool.

Or you could use the Brush tool to color in the white areas; if you choose to put a foreground assistant layer in front of the canvas, you won’t paint over the lines!

To make this activity switch accessible, you can set up Sticky Points in each of the white areas.

**Creating a coloring-in activity**

To create a coloring-in activity, use the tools to draw a black and white outline picture; or if you already have a picture to color in, add it as a background assistant layer.
Then simply use the Fill tool and colors to fill in the white gaps. You can hide all the tools except the Fill tool.

Or you could use the Brush tool to color in the white areas; if you choose to put a foreground assistant layer in front of the canvas, you won’t paint over the lines!

To make this activity switch accessible, you can set up Sticky Points in each of the white areas.

**Creating a magic painting activity**

You can create an activity where the Eraser tool reveals a color picture:
To do this, add the color picture as the background assistant layer. Then, in Paint, remove the color – for example, use the Fill tool to make all the colored areas white.

You can now use the Eraser tool to erase the white and reveal the background picture! You can hide all the tools except the Eraser tool.

To make this activity switch accessible, place Sticky Points at intervals so the picture is revealed as each Sticky Point is selected.

**Putting stamps on a background**

To put stamps on a background picture, simply add a background assistant layer and use the Stamp tool.
To make this activity switch accessible, use a Sticky Points grid so the switch user can choose where to place the stamp. The Sticky Points can be scanned as row or column groups before individual Sticky Points are scanned.

**Creating a matching activity**

You can use Sticky Points to create matching activities:
First, either add a background assistant layer containing the words and pictures to match, or use the Text tool and Stamp tool to add the words and pictures to the canvas.

Then go to Edit Mode and put Sticky Points next to each of the words and pictures. You can now use the Line tool to draw lines between the Sticky Points! The use of Sticky Points ensures that this activity is accessible to all, including switch users and students who need guidance when moving the mouse cursor.

You can hide all the tools except the Line tool and hide unused color palettes if you wish to focus your student.
Printing your work

Printing your work

It is easy and straightforward to print something in Clicker:

Note: For students using switch access, it is recommended to configure a cell to open a scannable Print Dialog.

Printing a Document

To print a Document, click the Print icon on the Document Toolbar, or open the Document menu and select Print Document.
You can choose to print the Document by itself, or with the currently open grid by clicking the relevant icon.

Clicking the Options button will allow you to specify a header or footer to be printed on each printed page by entering text into the appropriate text box. Checking Print the current date will ensure that today's date appears on each printed page.

From v6.15 onwards, a standard Windows printer window will appear after clicking the Print button. This will allow you to select which printer is used from the drop-down list of installed printers on your computer. There are also options for specifying the range of pages, along with the number of copies printed.

Clicking the Properties button will open the selected printer's properties, where you will be able to specify further printing options specific to that printer.

**Printing a Clicker Set**

To print a Clicker Set, open the Clicker Set menu and select Print Clicker Set, or click the Print icon on the Click & Edit Toolbar if applicable.
You can choose to print the current grid or page, or the entire Clicker Set by clicking the relevant icon. Click the Options button for a set of Advanced Options relating to how your grids will appear on printed pages.

From v6.15 onwards, a standard Windows printer window will appear after clicking the Print button. This will allow you to select which printer is used from the drop-down list of installed printers on your computer. There are also options for specifying the range of pages, along with the number of copies printed.

Clicking the Properties button will open the selected printer's properties, where you will be able to specify further printing options specific to that printer.

**Advanced Options**

**Page options**

You can specify a header or footer to be printed on each printed page by entering text into the appropriate text box. Check Print the current date to have the today's date appear on each page.

- *Keep the grid shape* - retains the aspect ratio of the grid or page when checked.
- *Print grids as big as possible* - causes the grid or page to fill the entire printed page.
Printed Documentation

When this is unchecked, you can specify the size of grids and pages by entering numbers into the **Width** and **Height** boxes.

If printing an entire Clicker Set, grids and pages are printed to one page each. To have one or more appear on a single page, make a selection from the drop-down list on the right.

**Print Options**

- **Print the grid background** - the background to grids and pages will only be printed if this is checked.

- **Print cells with "Don’t Print" in the cell properties** - cells that have been specified to **not be printed** will be printed with this option checked.

Click **Page Setup** to change things like paper size and printer margins.
User Preferences

Your preferences are personal options that enable you to customize your user experience with Clicker. These are saved for the current Windows user account. You can also save a named set of user preferences that can then be chosen from the Quick Start window.

To access these settings, open the Options menu and select User Preferences.

Use these to change preferences relating to the Document, Spellchecker, Predictor, Speech, Instant Pictures, on-screen keyboard, disabling Edit Mode, and the visibility of toolbar icons.

Click a link below for detailed information about each tab:

- **Document** - spellchecking settings and default formatting
- **Speech** - choose and configure a speech engine
- **Media** - preferences relating to Media Libraries and Instant Pictures
- **Clicker Sets** - disable Edit Mode and specify an on-screen keyboard
- **Predictor** - change the level of word prediction and shortcut keys
- **Look and Feel** - choose which tools to appear in the Document and Grid Toolbars.

Preference tabs

Document
Spelling:

• **Automatically capitalize word at start of sentence** – if you forget to add a capital letter at the beginning of a sentence, Clicker can add it for you

• **Automatically capitalize names (proper nouns)** – Clicker can add capital letters to proper nouns, if found in its dictionary

• **Check spelling as you type (red underline)** – if you type a word that is not in Clicker’s dictionary, it can underline it in red. You can then right-click the word to see suggested spellings, and click one to correct a word

Defaults:

• **Default Font** – choose a font type and size from the drop-down lists. Use the B button to make text **bold** and the I button to make text *italicized*. Click the Line spacing button to set the distance between lines by choosing an option from the drop-down list

• **Default filetype** – while you can specify your Document file type when you save it, this setting defines which file type is the default. Choose from:

  • Clicker 6 Document
  • Microsoft Word Document
Recent Files

• Display recent documents in Quick Start and Recent files windows – Uncheck this checkbox to stop Clicker keeping a list of recent Documents

Speech

You can change which speech engine is used to speak text, as well as define what will get spoken and the pace of the speech.

Speech

Select a voice from the drop-down list of installed speech engines on your computer. Heather and Graham are supplied with Clicker 6. Click and drag the slider to change the speed of the voice. Click Try to hear a speech example with your new voice and speed settings.

Text Highlighting
When Clicker speaks a section of text, you can choose to have it highlighted as it is spoken. **Block-highlighting** will highlight a block of space behind each word rather than the word itself. The highlight color is shown; you can choose a different color by clicking on it.

**In Document, speak**

- **Letters (as you type)** – hear every letter typed in your Document
- **Words (when space is entered)** – hear words spoken as they are written
- **Sentences (when punctuated at end)** – hear sentences spoken as they are written
- **Words when clicked** – hear words by clicking on them

**Clicker Set and Predictor**

- **Allow right-click (Mac: ctrl-click) to hear words** – hear words before you click on them to add them to the Document
- **Allow Ctrl + number keys/keypad to hear words** – hear words supplied by the Predictor before you add them to the Document

**Media**

A list on the left of this tab displays the [Media Libraries](#) currently registered on your computer. It defines the selection and order of libraries for use with [Instant Pictures](#) in various locations.
Check a library’s checkbox for it to be used with Instant Pictures. Use the arrow buttons to change a library’s position in the list. Media Libraries are searched in descending order.

On the right, you can specify whether you want Instant Pictures to appear in the Document, the Spellchecker, and Predictor by checking the relevant checkboxes.

If you’ve chosen Instant Pictures to appear in the Document, you can specify the size of the images that appear by making a selection from the Picture Size drop-down box.

Additionally, you can choose what locations appear in the Media tab and Media Browsers by making a selection from the Allow user to browse drop-down list:

- **Computer and all libraries** – users can browse all locations
- **All libraries** – users cannot browse the computer, only Media Libraries
- **Checked Libraries** – users can only browse Media Libraries which are checked in the opposite list
**Clicker Sets**

Unchecking **Enable Edit Mode** will completely disable a user’s ability to **edit** a Clicker Set. However, it will still be possible to **create** new Clicker Sets.

Normally, it is possible to **change a grid's height** in order to show more or less of the Document behind it. This will result in the grid’s objects being dynamically resized to fit the new grid size. This can be prevented by unchecking the second checkbox.

Make a selection from the **My preferred on-screen keyboard** drop-down list to choose which **on-screen keyboard** is displayed when you click the **Show Keyboard** icon. The list will include any keyboards you have **saved yourself**, along with these six:

- **Qwerty** – keys arranged as per a standard Qwerty keyboard
- **Frequency** – keys arranged in rows in decreasing order of frequency from left to right (useful for **switch users**)

*Note: To choose which libraries are used for Instant Pictures in Clicker Sets, see the Media tab in Clicker Set Properties.*
• **Alphabetical** – keys arranged alphabetically

• **Alphabetical/Qwerty/Frequency Prediction** – as above, with additional cells that display Predictor results

**Open my keyboard when Clicker 6 starts** – your preferred on-screen keyboard will always open when Clicker launches if this checkbox is enabled.

**Note:** To create your own keyboards, see [Creating and editing a keyboard](#).

**Predictor**

Move the slider to select a preset level of word prediction for the Predictor. Each level has its own setting for a number of options, which are shown towards the right.

Using the slider is the quickest way to set the level of prediction. However, if you wish to customize your prediction settings in detail, click **Custom Level**.

Click **Default** to set the level of prediction back to Level 3.
Predictor keys

**Use the number keys** – use the number keys along the top of your keyboard to send the corresponding word from the Predictor list to the Document.

**Use the numeric keypad** – use the numeric keypad to send a word from the Predictor to the Document. Ensure Numlock is enabled on your keyboard.

**Use Alt + a number key** – hold the Alt key and use the number keys or numeric keypad to add predicted words to your Document. This is useful if you want to use the keyboard for the Predictor, but are entering numbers regularly in a Document.

Predictor Options

- **Use SoundsLike prediction** – when checked, the Predictor will suggest words based on their phonetic sound. For example, if you type *skool*, one of the words suggested will be *school*.

Look and Feel

This tab lets you choose which tools are shown in the Document Toolbar and the Grid Toolbar.
Tools that are highlighted are shown; those unhighlighted are not. Click a tool to select or deselect it. Click **Show all tools** to select all tools at once. Clicking **Hide all tools** will deselect all tools at once.

You can also choose the size of the tool icons by making a selection from the **Tools size** drop-down list.

**Accessibility**

**Accessibility**

People who are unable to use a mouse may be able to use a mouse alternative, such as a joystick, tracker ball or eye tracking device. New features such as **Mouse Dwell** and **Sound Shift** make these much easier to use with Clicker.

For people unable to use a mouse alternative, keyboard, or touch screen, Clicker 6 is designed for use with **switches**.

To use Clicker 6 with switches, we recommend the Crick USB Switch Box to connect switches to your computer. To find out more about this, please contact us or visit our website at [www.cricksoft.com](http://www.cricksoft.com).

Additionally, you can also change **display options** to customize Clicker's appearance.

---

**Note:** Your User Access settings are saved along with your **User Preferences** (see **Saving your preferences**).

---

**Using switches**

When using switches as an access method in Clicker, a "scan" highlights groups of cells and tabs in turn. Pressing a switch will select the highlighted group. The scan then highlights individual cells.
within that group until you press the switch to select and activate the highlighted cell. You can also scan the Predictor, Grid Toolbar and Document Toolbar.

If you are using one switch, the scan moves to the next group or cell automatically after a delay (which you can change). If using two switches, you can move the scan to the next group or cell with one switch and select a cell or tab with the other.

You can simulate switch presses by using the following keyboard shortcuts. If you are using a switchbox other than our own, you will need to configure it to use these keyboard keys when Clicker is open:

- **F7** – Select
- **F8** – Move
- **Ctrl-Shift-6** – Hear right-click sound
- **Ctrl-Shift-5** – Reverse scan direction
- **Esc** – Exit scan group

**Note:** Currently, it is not possible to use switch access in conjunction with Click & Edit.

**Using Scan Groups**

You can use Scan Groups to specify groups of cells that are scanned as one unit, and when selected, the individual cells are scanned (or a further subgroup of cells).
The Scan Groups feature also lets you change the appearance and color of the scan for a group, specify an auditory cue, and alter selection behavior. You can also disable a cell group so that it can only be selected after a previous group.

For more information on how to use the Scan Groups feature, see Using the Scan tab and Scan Group settings.

Changing User Access options

Scan options

To change your accessibility options, open the Options menu and select User Access.

To use switch access, select either Single Switch Auto Scan (if you are using one switch) or Two Switch User Scan (if you are using more than one switch) from the drop-down list at the top.
Connection – select Crick USB Switch Box from the drop-down list.

Information about the current switch access settings is shown. To change any of the switch access settings, select the option you want to change and then click Edit.

Timings – choose the scan delay (single switch only), acceptance delay, debounce delay, auto-repeat delay, when the scan starts (single switch only), and when to exit scan groups

Scan Type – choose the type, color and line thickness of the scan highlight, and how to scan the Clicker Set cells

Sound – choose options for the sound or speech when a switch is pressed

Switches – choose the action made by each switch

To change your accessibility options, open the Options menu and select User Access.
To change mouse pointer options including Mouse Dwell, select Mouse Pointer from the drop-down list at the top.
User Preferences

### Cell effects

**Rollover effect** – choose how you wish cells to appear when the mouse pointer hovers over them.

**Select effect** – choose how you wish cells to appear when clicked.

**Enlarge cells when the pointer is over them** – when checked, cells will appear much larger when the mouse pointer hovers over them.

### Mouse Dwell

If a user cannot press a button (for example, they are using eye tracking software), **Mouse Dwell** replaces the act of clicking a mouse button. Instead, a user can "dwell" on an item by holding the pointer relatively steady over it for a moment of time; it will respond as if it has been clicked.

Check **Use Mouse Dwell** to enable this feature. Click **Edit Settings** to configure detailed settings pertaining to sensitivity, timing, and distance.

**Note:** Currently, it is not possible to use Mouse Dwell in conjunction with Click & Edit.
Display options

You have the ability to change the way Clicker's appearance. Things like colors and fonts can be adjusted to suit your student's needs. Once enabled, these settings will continue to be applied every time you launch Clicker.

Clicker Set Display

**Color scheme** – to choose one of the predefined color schemes for grids, pages and pop-ups, select an option from the drop-down list. To choose your own colors, choose Custom from the list and then choose the colors by clicking on the respective color buttons.

**In cells, always use this font** – check this to choose the font is used for all grids, pages and pop-ups from the drop-down list. You can also make the font **bold** or *italicised*.

Document Display

**Default Magnification** – to use a high zoom level so you can read text in the Document easily, select a magnification level from the drop-down list.
**Color scheme** – to choose one of the predefined color schemes for Documents, select an option from the drop-down list. To choose your own colors, choose **Custom** from the list and then choose the colors by clicking on the respective color buttons.

**Always use this font** – to define the font used in all Documents, select your preferred font, font size, and font style options.

**Using the Scan tab**

Open the **Scan** tab by clicking on it in the **Sidebar** in **Edit Mode**. It allows you to group cells together in “scan groups” and to define how these groups, along with other items, are scanned when scanning is enabled in **User Access**.

To add a cell to the Scan tab, drag and drop it to the required location.

Items already in the Scan tab can be dragged to different positions and moved in and out of scan group folders. Alternatively, select the item you wish to move and use the **arrow** icons. Click the **Scan Delay** icon to specify how long an item is selected for.
By default, a single empty group is created (Group_1). To add a new scan group, click the Add Group icon.

If the current grid, page, or pop-up has not been previously configured for scanning, all current cells will start in the Ungrouped Cells – Scan in Rows folder. Be aware that cells within clusters will scan sequentially, not in rows and columns. Disassemble a cluster into individual cells if you desire this type of scanning behaviour.

Remove any item by selecting it and clicking the Remove Cell/Group icon.

Scan Group settings

You can edit the properties of a group by selecting it and clicking Settings.

Group Name – type a name for the group

Auditory Cue – text entered here will be spoken when the scan reaches this group

Selection Behavior

After a selection has been made – the action chosen from the drop-down list will occur after a cell in the group has been selected

To exit this group – choose how to exit a group by selecting an action from the drop-down list

Highlight Appearance

Use a different highlight style when highlighting cells in this group – when checked, these options become available:

Highlight the background of a cell – when checked, a cell’s background will be colored the same as the highlight when highlighted

Draw a line around the cell - the line will appear around a highlighted cell in this group

Enlarge the cell – a cell in this group will display larger than normal when highlighted

Don’t draw an outline or enlarge cell – this is best used when the highlight background checkbox is checked

Highlight Color – the color shown will be used to highlight cells in this group. Click it to change it

Full Screen options
To determine how Clicker 6 is displayed when it is started, open the **Options** menu and select **Program Management**.

There are three startup options to choose from:

- **As big as possible** – the Clicker window will be maximised to cover the desktop
- **In the center of the screen** – the Clicker window will be 1024 x 768 and appear in the middle of the desktop
- **In Full Screen mode** – Clicker will occupy the entire screen. You can toggle this with the **F11** key at any time.

**Saving your preferences**

Your **User Preferences**, **Favorites**, and **User Access** options are automatically saved as they are altered to the current user’s Windows user account.

Therefore, if used on a network where each student has their own account, their Clicker user data will follow them to whichever networked computer they log onto.

If a user of Clicker does not have their own Windows user account, and multiple people are sharing one account, then it is possible to save someone’s Clicker user data to a file which can then be loaded when Clicker is launched.

To do this, open the **Options** menu, hover over **Import and Export**, and select **Export User Options**. You will then be asked to supply a name and location for the file. The filename should ideally be the name of the user, as it will subsequently appear in a **User** list on the **Quick Start** screen.

The default save location is the **Users** folder within your **Clicker Shared Files**. Save files to this location if you want them to appear in Quick Start, otherwise you can choose somewhere different if you wish to transport these user settings to another computer, for example.
Using different languages

Clicker 6 has been designed with a view to supporting a variety of languages. The program itself will be made available in several languages for different regions in the future. Not only will this include translation of the interface text, but also include language-specific activities and resources.

Please check our website for more information: www.cricksoft.com.

• What changes?

• Setting a language

What changes?

Regardless of the language of the program interface, Clicker has several language-sensitive components that can use various different languages according to their relevant settings. This can include regional differences. For example, in the case of Spanish, Clicker can accommodate Latin American Spanish in addition to European Spanish.

These components are:

• Speech

• Predictor

• Spellchecker

• Keyboard layouts

• Picture Libraries used for Instant Pictures
  (See Languages in Media Libraries for further information).

Each of these components will attempt to load the correct files based on a chosen language. Initially, they will try to locate a language file for the correct language and locale. If unavailable, they will try to load a file based only on language. If that is also unavailable, the feature will become disabled.

For example, the Predictor requires a series of database files to work. When a language is set, the Predictor will look for a prediction database file in the right language and locale; if it fails, it will look for a file that is only in the correct language. If it can’t find that either, the Predictor will be disabled and its
interface icon will become grayed out until a language is chosen that has the relevant database files available.

**Setting a language**

Upon installation, Clicker sets a **default** language and locale based on the version that’s installed. For example, the American version of Clicker 6 will set this to be **English (United States)**.

Additionally, it will also store preferred locales for other languages, e.g. the American version will set a preferred locale of **French Canadian** for French and **Latin American** for Spanish. Should these languages be used in the future, these preferred locales will be taken into consideration.

You can change the current language of Clicker from the default in two ways.

1) Click the arrow next to the `Speak Text` icon in the **Document Toolbar** and select a voice from the drop-down menu. The language of the voice will become the current language for Clicker if no Clicker Sets are open.

2) When a Clicker Set is opened, **the language that has been set** for it will become the current language for Clicker. This will override the above method by hiding voices of a different language.

Most of the time, the current language is influenced by an open Clicker Set. Therefore, you can open more than one Clicker Set of the **same** language. Opening a different language Clicker Set will show a prompt explaining that currently open Clicker Sets must be closed.
Clicker Apps

Combining classic Clicker features with the latest classroom technology, our Clicker Apps give your students access to proven literacy support tools developed specifically for the iPad. Each app focuses on one key aspect of Clicker 6 and has a child-friendly, designed-for-touch interface perfectly suited to learners across the elementary age range.

Clicker Sentences
Clicker Docs

We understand that teachers and students will not always have access to their iPads, so we have ensured that Clicker Apps and Clicker 6 are able to ‘talk’ to each other. This gives you the flexibility to create activities within Clicker 6 and then export them to your iPads, or open your students' Clicker Apps work in Clicker 6.

To open a Clicker Apps Document, Sentence Set or Word Bank in Clicker 6, browse to its location in Clicker Explorer.

To export a version of your current Clicker Set for use in a Clicker App, open the Clicker Set menu, hover over Export Clicker Set for App and choose one.

A wizard will appear that resembles the Edit View of that particular Clicker App, which will be populated with data from your Clicker Set. You can alter the text that will be used, along with various other options. Click Export to save the exported activity in your desired location.

You can then email the file to an iPad, or upload it to a Dropbox account that is linked to the Clicker App.
Getting help

Technical Support

We provide free technical support to registered users of our products. If you have not found a solution after consulting the user guide or the support section on our website, you can contact us for support in three ways:

1. Use the Support Request form on our website
2. Email us at support@cricksoft.com
3. Fax your issue to 203 221 2698

When contacting Technical Support, please try to include the following:

• Your name (and organisation name if applicable)
• Your version number. This is printed on your CD.
  You can also open the Help menu and select About Clicker 6
• The version of Windows operating system you are using
• A detailed explanation of the problem and what led to it happening
• Any error messages that occur (you can supply a screenshot)
• A Clicker 6 application log

The more information you can supply, the better equipped we will be to find a solution to your problem!

Generating an application log

Should a problem occur, you can generate a Clicker 6 application log to send to Technical Support.

1. Click the Application Log icon at the bottom right corner of the window
2. Click the Save button
3. Save the log file somewhere convenient (such as your desktop)

4. Attach this log file to your email when you contact Technical Support

This is often the quickest way of discerning the cause of your problem.

**Folder locations**

![Folder Locations Image]

To find out where your Clicker folders are located, open the Options menu, select Program Management and then select the Folder Locations tab.

**Our contact details**

As well as welcoming any technical support queries, we also appreciate your comments on Clicker 6 – your suggestions will influence future versions. Email us your comments at feedback@cricksoft.com and tell us what you think!

**Crick Software**

**Email:** General Information: USinfo@cricksoft.com

Sales: USsales@cricksoft.com

Technical Support: support@cricksoft.com

**Website:** www.cricksoft.com

**Toll-free:** 1 866 33 CRICK

**Phone:** 203 221 2697

**Fax:** 203 221 2698